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TOOLS for MOTIF ES6/MOTIF ES7/MOTIF ES8
Installation Guide/Installationshandbuch/Manuel d’installation

 

SPECIAL NOTICES

 

• The software and this Installation Guide are exclusive copyrights of Yamaha Corporation.

• Use of the software and this guide is governed by the SOFTWARE LICENSING AGREEMENT which the purchaser fully agrees to upon breaking the 
seal of the software packaging. (Please read carefully the AGREEMENT at the end of this guide before installing the application.)

• Copying of the software or reproduction of this guide in whole or in part by any means is expressly forbidden without the written consent of the 
manufacturer.

• Yamaha makes no representations or warranties with regard to the use of the software and documentation and cannot be held responsible for the 
results of the use of this guide and the software. 

• Copying of the commercially available music data is strictly prohibited except for your personal use.

• The company names and product names in this Installation Guide are the trademarks or registered trademarks of their respective companies.

• Software such as theUSB MIDI driver may be revised and updated without prior notice.  Make sure to check and download the latest version of the 
software from the following site.
http://www.yamahasynth.com/down/index.htm

• Future upgrades of application and system software and any changes in specifications and functions will be announced separately.

 

BESONDERE HINWEISE

 

• Dieses Programm und diese Installationsanleitung sind im Sinne des Urheberrechts alleiniges Eigentum der Yamaha Corporation.

• Die Benutzung des Programms und dieser Anleitung unterliegt der SOFTWARE-LIZENZVEREINBARUNG, mit der sich der Erwerber durch Öffnen 
des Siegels der Programmverpackung uneingeschränkt einverstanden erklärt. (Bitte lesen Sie die VEREINBARUNG am Ende dieser Anleitung vor 
Installation der Anwendung sorgfältig durch.)

• Das Kopieren der Software und die Reproduktion dieser Anleitung, in welcher Form auch immer, in Teilen oder als Ganzes, sind nur mit schriftlicher 
Genehmigung des Herstellers erlaubt und sonst ausdrücklich verboten.

• Yamaha leistet keinerlei Garantie hinsichtlich der Benutzung des Programms und der zugehörigen Dokumentation und übernimmt keine 
Verantwortung für die Ergebnisse der Benutzung dieser Anleitung oder des Programms.

• Das Kopieren im Handel erhältlicher Musikdaten ist nur für Ihren Privatgebrauch zulässig und sonst streng untersagt.

• Die in dieser Installationsanleitung erwähnten Firmen- und Produktnamen sind Warenzeichen bzw. eingetragene Warenzeichen der betreffenden 
Firmen.

• Software wie z.B. der USB MIDI Driver kann ohne vorherige Benachrichtigung überarbeitet und aktualisiert werden. Achten Sie darauf, auf der 
folgenden Website nach der neuesten Version der Software zu suchen und sie herunterzuladen.
http://www.yamahasynth.com/down/index.htm

• Zukünftige Aktualisierungen von Anwendungs- und Systemsoftware sowie jede Änderung der technischen Daten und Funktionen werden separat 
bekanntgegeben.

 

REMARQUES PARTICULIERES

 

• Les droits d’auteurs (copyright) de ce logiciel et de ce manuel d’installation appartiennent exclusivement à Yamaha Corporation.

• L’usage de ce logiciel et de ce manuel est défini par l’accord de licence auquel l’acheteur déclare souscrire sans réserve lorsqu’il ouvre le sceau de 
l’emballage du logiciel. (Veuillez donc lire attentivement l’accord de licence du logiciel situé à la fin de ce manuel avant d’installer le logiciel.)

• Toute copie du logiciel et toute reproduction totale ou partielle de ce manuel, par quel moyen que ce soit, est expressément interdite sans l’autorisation 
écrite du fabricant.

• Yamaha n’offre aucune garantie en ce qui concerne l’utilisation du logiciel et de la documentation. Yamaha ne peut en aucun cas être tenu responsable 
des dommages éventuels résultant de l’utilisation de ce manuel et de ce logiciel.

• Toute copie de données musicales commercialisées est formellement interdite, sauf pour usage personnel.

• Les noms des firmes et des produits apparaissant dans ce manuel d’installation sont des marques commerciales ou des marques déposées appartenant à 
leurs détenteurs respectifs.

• Les logiciels tels que le pilote USB MIDI sont susceptibles d'être révisés et mis à jour sans avertissement préalable. Veuillez toujours à vérifier la version 
du logiciel utilisée et à télécharger la dernière version en date sur le site suivant :
http://www.yamahasynth.com/down/index.htm

• Les remises à jour du programme et du système ainsi que toute modification des caractéristiques et fonctions seront annoncées séparément.

 

En
g
lis

h
D

eu
ts

ch
Fr

a
n
ça

is



                             

En
g
lish
Important Notices about the CD-ROM
Data Types
This CD-ROM includes the application software. Please refer to pages 4 (Windows) or 8 (Macintosh) for software installation instructions. 

Never attempt to play back the CD-ROM on an audio CD player. Doing so may result in damage to your hearing as well as to your CD player/audio 
speakers. 

Media format
The MOTIF ES6/MOTIF ES7/MOTIF ES8 is compatible with the following media formats.
• MS-DOS    • CD-ROM with ISO9660

The MOTIF ES cannot directly read the contents of the CD-ROM. The CD-ROM is intended for use only with a computer.

n If a read-only file is copied to the SmartMedia card in the MOTIF ES’s card slot or the USB storage device connected to the MOTIF ES, the file cannot be deleted from the MOTIF ES.

Operating System (OS)
The applications in this CD-ROM are provided in versions for both Windows and Macintosh operating systems. The installation procedure and the applications 
themselves differ depending on the operating system that you are using. Please refer to the appropriate installation instructions. 
For Windows, see page 4.
For Macintosh, see page 7.

CD-ROM Installation Procedure
Before breaking the seal of the software packaging, please read carefully the Software Licensing Agreement at the end of this guide.

1 Verify that your system meets the operating requirements of the software (Voice Editor, Plug-in Board Editors, driver, etc.).

.........................................................................................................................................................................................................Windows: page 4; Macintosh: page 7

2 Install the appropriate driver to your computer, and make the necessary settings.  .................................................................Windows: page 4; Macintosh: page 8

3 Install the software (Voice Editor, etc.).  ......................................................................................................................................Windows: page 5; Macintosh: page 9

4 Start up the software.

For subsequent operations, refer to the owner’s manual for each software program (online help/PDF manual).

n  In order to view PDF files, you will need to install Acrobat Reader in your computer (Windows: page 5; Macintosh: page10).

Quick solutions
• Changing the MIDI port settings of the USB Driver..........page 10
• The driver cannot be installed.............................................page 11
• Playback response is not correct..........................................page 11
• How can I delete or re-install the driver? ...........................page 11

For Windows Users
Contents of the CD-ROM
The CD-ROM contains a variety of applications (with installers) and data in the following folders.

* Unfortunately, Yamaha makes no guarantee concerning the stability of these programs (marked with *) nor can it offer user support for them.
• All the applications listed above are supplied with online/PDF manuals.
• You can start the Voice Editor for MOTIF ES6/7/8 or Multi Part Editor for MOTIF ES6/7/8 software as either a stand-alone software or a plug-in application in an Open Plug-in Technology compatible 

application. Refer to the owner’s manual of the client application (sequencer, etc.) for details on using the Voice Editor for MOTIF ES6/7/8 or Multi Part Editor for MOTIF ES6/7/8 as a plug-in software.

Folder Name Application Name Contents

Acroread_ Acrobat Reader* PDF (Portable Document Format) viewer. Enables you to view the PDF manual for each application.

Sq01_ SQ01 V2 New version of SQ01 V2 with full-scale Audio Mixier feature, for easily creating and playing back your 
own songs on computer. This can be used as a host application for the Plug-in software.

AudioMixer_ (SQ01 V2) Plug-in software for the SQ01 V2, which enables mixing of audio tracks.  (Cannot be used as a stand-
alone application.)

Twe_ YAMAHA Wave Editor TWE 2.4.4 Enables you to edit the audio (wave) data on your computer. 

Tools_ VEMOTES_ Voice Editor for MOTIF ES6/7/8 Enables you to edit the MOTIF ES Voices on your computer.

MEMOTES_ Multi Part Editor for MOTIF ES6/7/8 Enables you to edit the Mixing parameters (such as effect) of the MOTIF ES on your computer when 
using the MOTIF ES as a multi-timbral tone generator. 

USBdrv_ YAMAHA USB MIDI Driver (for Win98, Me) Enables your computer to communicate with the MOTIF ES when your computer and the MOTIF ES 
are connected using a USB cable.USBdrv2k_ YAMAHA USB MIDI Driver (for Win2000, XP)

NIdemo_ Demo for the software synthesizer* Demo for the VST plug-in software synthesizer of Native Instruments. 
In the “NIdemo” folder, double-click on “***Setup.exe” of which the file name is the plug-in software 
to be installed, then follow the on-screen instructions.

DemoSong Song data Demo songs for the SQ01 V2 when using the MOTIF ES as a tone generator.
2   TOOLS for MOTIF ES6/MOTIF ES7/MOTIF ES8 Installation Guide
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About Open Plug-in Technology
You can start the Voice Editor for MOTIF ES6/7/8 or the Multi Part Editor for MOTIF ES6/7/8 software as either a stand-alone software or a plug-in application in 
an Open Plug-in Technology compatible application.
Open Plug-in Technology (OPT) is a newly developed software format that allows control over MIDI devices from a music software sequencer.  For example, this 
allows you to start up and operate various parts of your music system, such as Plug-in Board editors, and mixing control editors – directly from an OPT-compatible 
sequencer, without having to use each separately.  This also makes it unnecessary to set MIDI drivers for each application, streamlining your music production 
system and making all operations more convenient and seamless.

About the OPT Levels
The client application and its compatibility with OPT can be divided into three levels, as shown below.

Level 1 – OPT Panels provides basic support for opening and displaying OPT control panels that can transmit data via the clients’ external MIDI ports. 
Typically this allows basic hardware editor control panels to operate properly.

Level 2 – OPT Processors provides support for real-time MIDI processors and panel automation. Typically this allows both real-time and offline MIDI effects 
(e.g. Arpeggiators, transposers etc.) to operate properly and supply automation to OPT panels. 

Level 3 – OPT Views provides support for edit views and MIDI processors/panels that require direct access to client sequencer storage structures. Typically 
this allows sophisticated MIDI edit views to be supported (e.g. List editors, Auto Accompaniment, Data Checkers etc.).

OPT Level Implementation for the Voice Editor
This chart shows the OPT-compatibility of the Voice Editor for MOTIF ES6/7/8.

n Certain operations may not work as expected if there is no corresponding function in the client application (sequencer, etc.).  The highest level of implementation for the client application is 
indicated in the OPT logo (which appears along with the version information in the application).

OPT Level Implementation for the Multi Part Editor
This chart shows the OPT-compatibility of the Multi Part Editor for MOTIF6/7/8.

All operations of the Multi Part Editor for MOTIF ES6/7/8 can be utilized when running as a plug-in within Level 2 (Processors) and Level 3 (Views) host 
applications. Some host applications may not support remote control.

n Certain operations may not work as expected if there is no corresponding function in the client application (sequencer, etc.).  The highest level of implementation for the client application is 
indicated in the OPT logo (which appears along with the version information in the application).

OPT levels of the client application
Voice Editor for MOTIF ES6/7/8 operation

Operation support Operation limits

VIEWS (Level 3)              Yes None

PROCESSORS (Level 2)  Yes None

PANELS (Level 1)          Yes (with limitations) Bulk reception

OPT levels of the client application
Multi Part Editor for MOTIF ES6/7/8 operation

Operation support Operation limits

VIEWS (Level 3)              Yes None

PROCESSORS (Level 2)  Yes None

PANELS (Level 1)           Yes Bulk reception
   TOOLS for MOTIF ES6/MOTIF ES7/MOTIF ES8 Installation Guide   3



                                                                           

     

En
g
lish
Minimum System Requirements
The system requirements below may differ slightly depending on the particular 
operating system.

• SQ01 V2
OS: Windows 98/Me/2000/XP Home Edition/

XP Professional
Computer: 500 MHz or higher; Intel Pentium/Celeron processor

(750 MHz or higher when using Windows XP)
Available Memory: 256 MB or more
Hard Disk: 300 MB or more
Display: 1024 x 768 dots or more

• Voice Editor for MOTIF ES6/7/8
OS: Windows 98/Me/2000/

XP Home Edition/XP Professional
Computer: 166 MHz or higher;

Intel Pentium/Celeron processor
Available Memory: 32 MB or more
Hard Disk: 24 MB or more
Display: 640 x 480, High Color (16 bit) or higher

• Multi Part Editor for MOTIF ES6/7/8
OS: Windows 98/Me/2000/XP Home Edition/

XP Professional
Computer: 166 MHz or higher;

Intel Pentium/Celeron processor
Available Memory: 32 MB or more
Hard Disk: 32 MB or more
Display: 1024 x 768, High Color (16 bit) or higher

• TWE V2.4.4
OS: Windows 95/98/Me/2000/NT/XP
Computer: 166 MHz or higher;

Intel Pentium/Celeron processor
Available Memory: 24 MB or more
Hard Disk: Average access time 30 ms or less
Display: 800 x 600, 256 colors or more 

• USB MIDI Driver 
OS: Windows 98/Me/2000/XP Home Edition/

XP Professional
Computer: 166 MHz or higher;

Intel Pentium/Celeron processor
Available Memory: 32 MB or more

(64 MB or more is recommended)
Hard Disk: 2 MB or more

n The Minimum System Requirements described above are current as of June 2003. 
Keep in mind that the software is often updated and the system requirements are subject 
to change.  You can check the latest version information of each program and its system 
requirements at the following website. 
http://www.yamaha.co.jp/product/syndtm/index.html

Software Installation

Uninstall (Removing the installed applictaion)
To remove the installed applictaion software: 
Select [START] → [Settings] → [Control Panel] → [Add/Remove 
Programs] → [Install/Uninstall], then select the application to be 
removed and click [Add/Remove...]. 
Follow the on-screen instructions to uninstall the application.

n The button names or menus may differ depending on the computer OS.

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •  
Acrobat Reader

 
In order to view the electronic (PDF) manuals included with each application, 
you’ll need to install Acrobat Reader.

 

n If an older version of Acrobat Reader is installed on your PC, you’ll need to uninstall it 
before proceeding.

1 Double-click on the “Acroread_” folder. 
Four different language folders will be displayed.

2 Select the language you want to use and double-click on its folder. 
The file “ar***.exe” file will be displayed. (“***” indicates the selected 
language.)

3 Double-click on “ar***.exe.”
Acrobat Reader Setup Dialog box will be displayed.

4 Execute the installation by following the on-screen directions.

After installation is complete, the Acrobat folder appears on your PC (in 
Program Files, as the default).
For information on using the Acrobat Reader, refer to the Reader Guide in the 
Help menu.

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •
USB MIDI Driver
To operate the MOTIF ES from your computer via USB, you’ll need to install 
the appropriate driver software.
The USB-MIDI driver is software that transfers MIDI data back and forth 
between sequence software and the MOTIF ES via a USB cable.

For Windows 98/Me: See below.
For Windows 2000: See page 5.
For Windows XP: See page 5.

z Installing the driver on Windows 98/Me

1 Start the computer.

2 Insert the included CD-ROM into the CD-ROM drive.

3 First, make sure the POWER switch on the MOTIF ES is set to OFF, then 
use a USB cable to connect the USB terminal of the computer (or the USB 
hub) to the USB TO HOST connector of the MOTIF ES. When the MOTIF 
ES is turned on, the computer automatically displays the “Add New 
Hardware Wizard.” If the Add New Hardware Wizard does not appear, click 
“Add New Hardware” in the Control Panel.

n For Windows Me users, check the radio button to the left of “Automatic search for a 
better driver (Recommended)” and click [Next]. The system automatically starts 
searching and installing the driver. Proceed to Step 8. If the system does not detect 
the driver, select “Specify the location of the driver (Advanced)” and specify the 
CD-ROM drive’s “USBdrv_” folder to install the driver. 

4 Click [Next].
The window enables you to select the search method.

5 Check the radio button to the left of “Search for the best driver for your 
device. (Recommended).” Click [Next]. The window enables you to select a 
location in which to install the driver.

6 When using Windows 98, check the “Specify a location” box, click 
“Browse..”, then specify the USBdrv directory of the CD-ROM drive (such 
as D:\USBdrv_\) and continue the installation. 

When using Windows Me, check the “CD-ROM drive” box and uncheck all 
other items. Click [Next].

n When using Windows Me, the system may ask you to insert a Windows CD-ROM 
while it checks for the driver. Specify the USBdrv directory of the CD-ROM drive 
(such as D:\USBdrv_\) and continue the installation.

7 When the system detects the driver on the CD-ROM and is ready for 
installation, it is shown as a message on the screen.
Make sure that the “YAMAHA USB MIDI Driver” is listed, and click 
[Next]. The system starts the installation.

8 When installation is complete, a message indicating so appears.
Click [Finish].

n Some computers may take about ten seconds to show this screen after the 
installation is complete.

The driver has been installed.

Computer

MOTIF ES

USB cable

Driver

Sequence
Software
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z Installing the driver on Windows 2000

1 Start the computer and use the “Administrator” account to log into 
Windows 2000.

2 Select [My Computer | Control Panel | System | Hardware | Driver Signing | 
File Signature Verification], and check the radio button to the left of “Ignore 
-Install all files, regardless of file signature” and click [OK].

3 Insert the included CD-ROM into the CD-ROM drive.

4 First, make sure the POWER switch on the MOTIF ES is set to OFF, then 
use a USB cable to connect the USB connector of the computer (or the USB 
hub) to the USB TO HOST connector of the MOTIF ES. When the MOTIF 
ES is turned on, the computer automatically displays the “Found New 
Hardware Wizard.” Click [Next].

5 Check the radio button to the left of “Search for a suitable driver for my 
device. (Recommended).” Click [Next].
The window that appears enables you to select a location in which to install 
the driver.

6 Check the “CD-ROM drives” box and uncheck all other items. Click [Next].

n The system may ask you to insert a Windows CD-ROM while it checks for the 
driver. Specify the “USBdrv2k_” directory of the CD-ROM drive (such as 
D:\USBdrv2k_\) and continue the installation.

7 When the installation is complete, the system displays “Completing the 
Found New Hardware Wizard.” Click [Finish].

n Some computers may take about ten seconds to show this screen after the 
installation is complete. 

8 Restart the computer. 
The driver has been installed.

z Installing the driver on Windows XP

1 Start the computer.

2 Select [Start] → [Control Panel].
If the control panel appears as “Pick a category”, click “Switch to Classic 
View” in the upper left of the window.
All control panels and icons will be displayed.

3 Go to [System] → [Hardware] → [Driver Signing] → [File Signature 
Verification], and check the radio button to the left of “Ignore -Install all 
files, regardless of file signature” and click [OK].

4 Click the [OK] button to close System Properties, and then click “X” in the 
upper right of the window to close the Control Panel.

5 Insert the included CD-ROM into the CD-ROM drive.

6 First, make sure the POWER switch on the MOTIF ES is set to OFF, then 
use a USB cable to connect the USB connector of the computer (or the USB 
hub) to the USB TO HOST connector of the MOTIF ES. When the MOTIF 
ES is turned on, the computer automatically displays the “Found New 
Hardware Wizard.”

n Some computers may take a few minutes to show this screen.

7 Check the radio button to the left of “Search for a suitable driver for my 
device. (Recommended).” Click [Next].
The system starts the installation.

8 When the installation is complete, the system displays “Completing the 
Found New Hardware Wizard.” Click [Finish].

n Some computers may take about a few minutes to show this screen after the 
installation is complete.

9 Restart the computer.
The driver has been installed.

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •
SQ01 V2
In the procedure of installing the SQ01 V2, you can also install the Voice Editor 
for MOTIF ES 6/7/8, Multi Part Editor for MOTIF ES 6/7/8, and Wave Editor 
TWE together as plug-in software of the SQ01 V2. 

1 Double-click on the “SQ01_” folder. 
Various files including “setup.exe” will be displayed.

2 Double-click on “Setup.exe.”
SQ01 Setup Dialog box will be displayed.

3 Execute the installation by following the directions appearing on the screen.
After the installation, select “Restart”. After restarting Windows, you will 
find the YAMAHA folder on your PC (Program Files as the default) and 
SQ01 folder in the YAMAHA folder.
Refer to the online manuals for instructions on how to use the application.

SQ01 V2 MIDI Setup
1 Start the SQ01 V2.

Choose [Programs] from the [Start] menu, then select [YAMAHA 
SQ01 Ver.2.0] → [SQ01].

2 From the [Setup] menu (Track View window), select [MIDI] 
→[Device], to call up the “Device” page of the “MIDI” dialog.

3 Select the appropriate output port (for example, “YAMAHA USB 
OUT 0-1”) in the [OUT] box, to use the USB connection with the 
MOTIF ES.

4 Select the appropriate input port (for example, “YAMAHA USB IN 
0-1”) in the [IN] box, then click [OK] to close the dialog box.

nYou can select the audio driver and the audio in/out device if necessary. From the 
[Setup] menu, select [Audio] → [Device] to call up the “Device” page of the 
“Audio” dialog.

nThe USB connection to the MOTIF ES can only be used for transfer of MIDI data. 
No audio data can be transferred via USB. 

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •
Voice Editor and Multi Part Editor
Once you‘ve installed these software programs, you can use your computer to 
edit the Voices and Mixing settings of the MOTIF ES.

1 Double-click on the “Tools” folder in the CD-ROM. 
The “VEMOTES_” and “MEMOTES_” folders will be displayed. 

2 Double-click on the “VEMOTES_” folder or “MEMOTES_” folder. 
“setup.exe” file will be displayed. 

3 Double-click on the “setup.exe” file. 
The Voice Editor or the Multi Part Editor Tools setup dialog will be 
displayed. 

4 Execute the installation by following the on-screen directions. 

For details, refer to the each on-line Help or the each PDF owner’s manual. 

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •
TWE (using as a stand-alone software)
In the procedure of installing the SQ01 V2, you can also install the TWE, which 
enables you to edit the wave data directly on your computer, as plug-in software 
of the SQ01 V2. If you wish to install the TWE alone, follow the instructions 
below.

1 Double-click on the “Twe_” folder. 

2 Select the language that you want to use and double-click “setup.exe”. 

3 Execute the installation by following the on-screen instructions. 
For details on operation, refer to the PDF manual provided in the folder. 
   TOOLS for MOTIF ES6/MOTIF ES7/MOTIF ES8 Installation Guide   5
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MIDI port setting
(when starting the software as a stand-
alone application)
Before setting the MIDI port on the Voice Editor or Multi Port Editor, you 
should set the MIDI port from the MIDI SETUP toolbar. 

n When you start the Voice Editor or Multi Part Editor as a plug-in application in an Open 
Plug-in Technology compatible application, refer to the PDF manual of the respective 
software.

1 Start the Voice Editor or Multi Part Editor. 

2 Click the MIDI Setup button in the Toolbar called up via step #1. 

3 In the MIDI Setup window called up via step #2, click the [▼] button at the 
right end of each box and make the port settings as shown.

n In order for MIDI ports to be available here, you’ll need to select the relevant MIDI 
port within each application software (Voice Editor or Multi Port Editor). This is 
the port that you’ll use in the various software. For details on setting the MIDI port, 
refer to the on-line manual of each software. 

MIDI Setup button
6   TOOLS for MOTIF ES6/MOTIF ES7/MOTIF ES8 Installation Guide
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For Macintosh Users
Contents of the CD-ROM
The CD-ROM includes two folders: “International” and “Japanese.” Double-click on the “International” folder to open it. A variety of applications (with installers) 
and data are contained in the following folders.

* Unfortunately, Yamaha makes no guarantee concerning the stability of these programs (marked with *) nor can it offer user support for them.

• All the applications listed above are supplied with online/PDF manuals.

Minimum System Requirements
The system requirements below may differ slightly depending on the particular operating system.

• Voice Editor for MOTIF ES6/7/8
OS: Mac OS 8.6 through OS 9.22 (Mac OS X and Mac Classic environment are not supported)
Computer: A Macintosh computer with a PowerPC or later CPU
Available Memory: 18 MB or more
Hard Disk: 64 MB or more
Display: 800 x 600, 32,000 colors or more

• TWE V2.3
OS: Mac OS 7.6.1 through OS 9.22 (Mac OS X and Mac Classic environment are not supported)
Computer: A Macintosh computer with a PowerPC or later CPU 
Available Memory: 8 MB or more
Hard Disk: Average access time 30 ms or less
Display: 640 x 400, 256 colors or more 

• USB MIDI Driver 
OS: Mac OS 8.6 through OS 9.22 (Mac OS X and Mac Classic environment are not supported)
Computer: A Macintosh computer with a USB connector and a PowerPC or later CPU
Memory: 64 MB or more (128 MB or more is recommended)
n Turn off virtual memory.

Hard disk: 2 MB or more
Other: OMS 2.3.8 (included in the CD-ROM in the package)

n The Minimum System Requirements described above are current as of June 2003. 
Keep in mind that the software is often updated and the system requirements are subject to change.  
You can check the latest version information of each program and its system requirements at the following website. 
http://www.yamaha.co.jp/product/syndtm/index.html

Folder Name Application Name Contents
Acroread_ Acrobat Reader* PDF (Portable Document Format) viewer. Enables you to view the PDF manual for each 

application.

OMS_ OMS Open Music System (OMS)* Enables you to simultaneously use several MIDI applications on the Mac OS.

OMS Setup OMS Setup for YAMAHA Contains the OMS Setup files for Yamaha tone generators.

USBdrv_ YAMAHA USB MIDI Driver Enables your computer to communicate with the MOTIF ES when your computer and the 
MOTIF ES are connected using a USB cable.

VEMOTES_ Voice Editor for MOTIF ES6/7/8 Enables you to edit the MOTIF ES Voices on your computer.

Twe_ YAMAHA Wave Editor TWE 2.3 Enables you to edit the audio (wave) data on your computer. 

NIdemo_ Demo for the software synthesizer* Demo for the VST plug-in software synthesizer of Native Instruments. 
In the “NIdemo” folder, double-click on “***Demo Install/installer” of which the file name 
is the plug-in software to be installed, then follow the on-screen instructions.
   TOOLS for MOTIF ES6/MOTIF ES7/MOTIF ES8 Installation Guide   7
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Software Installation

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •  
Acrobat Reader

 
In order to view the electronic (PDF) manuals included with each application, 
you’ll need to install Acrobat Reader. 

1 Double-click on the “Acroread_” folder.
Three different language folders will be displayed: English, German and 
French.

2 Select the language you want to use and double-click on its folder.
“Reader Installer” will be displayed.
The Installer name may differ depending on the language you select.

3 Double-click on the “Reader Installer.”
Acrobat Reader Setup Dialog will be displayed.

4 Execute the installation by following the directions appearing on the screen.
After installation is complete, the Acrobat folder appears on your computer 
(in Hard Disk, as the default).
For information on using the Acrobat Reader, refer to the Reader Guide in 
the Help menu.

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •  
Open Music System (OMS) 2.3.8

 
OMS allows you to use several MIDI applications on the Mac OS at the same 
time.

1 Double-click on the “OMS” folder (English version only).
“Install OMS 2.3.8” will be displayed.

2 Double-click on “Install OMS 2.3.8.”
OMS Setup Dialog will be displayed.

3 Execute the installation by following the on-screen directions. 
After the installation, select “Restart.”

n After the installation is complete, you may encounter an error message warning 
that the installer did not close. In this case, go to the “File” menu and select “Quit” 
to close the installer. Then reboot the computer.

After restarting the Macintosh, you will find the “Opcode”/“OMS 
Applications” folder on your computer (Hard Disk, as the default).

4 Copy the “OMS_2.3_Mac.pdf” in the CD-ROM to the “OMS Applications” 
folder (drag-and-drop it to the folder).
Refer to the “OMS_2.3_Mac.pdf” (English version only) for information on 
how to use the application.

5 Copy the “OMS Setup for YAMAHA” in the CD-ROM to the “OMS 
Applications” folder (drag-and-drop it to the folder).
In the “OMS Setup for YAMAHA” folder you will find the OMS Setup files 
for the Yamaha tone generators, which can be used as templates.

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •  
USB MIDI Driver

 
To operate the MOTIF ES from your computer via USB, you’ll need to install 
the appropriate driver software.
The USB-MIDI driver is software that transfers MIDI data back and forth 
between sequence software and the MOTIF ES via a USB cable.

First install OMS before you install the USB-MIDI driver. Also, after installing 
the driver, you will need to set up OMS (above).

1 Start the computer.

2 Insert the included CD-ROM into the CD-ROM drive. The system displays 
the CD-ROM icon on the desktop.

3 Double-click the CD-ROM icon and double-click the “Install USB Driver” 
icon in the “USBdrv_” folder to display the following installation screen. 

4 The “Install Location” box displays the destination of the installation. If you 
wish to change the destination disk or folder, use the [Switch Disk] button 
and the pop-up menu to specify the desired destination.

n This box usually displays the start-up disk as the destination.

5 Click the [Install] button. The system displays a message prompting you to 
restart the computer.  Click [Continue] to close all other applications and 
restart.

n To cancel the installation, click [Cancel].

6 The installation starts. If the driver has already been installed, you will 
receive the following message. To return to step 3, press [Continue]. To 
complete the installation, click [Quit].

7 When the installation is complete, the system displays a message prompting 
you to restart the computer. Click [Restart]. The computer automatically 
restarts. The installed files can be found in the following locations:

• System Folder | Control Panels | YAMAHA USB MIDI Patch
• System Folder | Extensions | USB YAMAHA MIDI Driver
• System Folder | OMS Folder | YAMAHA USB MIDI OMS Driver

Computer

Sequence
Software

OMS Driver

USB cable

MOTIF ES
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• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •  
Voice Editor

 
Once you‘ve installed these software programs, you can use your computer to 
edit the Voices of the MOTIF ES. 

1 Double-click on the “International” folder in the CD-ROM. 
“VEMOTES_” folder will be displayed. 

2 Double-click on the “VEMOTES_” folder. 
“Install VoiceEditorFor MOTIF ES” file will be displayed. 

3 Double-click on the “Install VoiceEditorFor MOTIF ES” file. 
The Voice Editor installation dialog will be displayed. Execute the 
installation by following the on-screen directions. 

4 After installing, restart the computer. 

For details, refer to the on-line Help or the PDF owner’s manual. 

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •  
TWE

 
With the TWE audio editing software, you can edit wave data directly on your 
computer.

1 Double-click on the “TWE” folder. 
Four different language folders will be displayed. 

2 Select the language that you want to use and double-click on its folder. 
The “YAMAHA TWE” folder will be displayed. 

3 Copy the “YAMAHA TWE” folder to the hard disk of your computer. 
For details on how to use TWE, refer to the on-line manual provided in the 
folder.

Setting up OMS
The OMS studio setup file for the MOTIF ES is contained in the included CD-
ROM. This studio setup file is used for setting up OMS. 

n Before performing the following procedure, the OMS and USB MIDI Driver should be 
installed. 

1 Use an USB cable to connect the USB terminal of the computer (or the USB 
hub) to the USB terminal of the MOTIF ES and turn the MOTIF ES’s power 
on. 

2 Start the computer. 

3 Insert the included CD-ROM into the CD-ROM drive of your Macintosh 
computer. The CD-ROM icon appears on the desktop. 

4 Double-click on the CD-ROM icon, “International”, “OMS”, and “OMS 
Setup for YAMAHA.” 
The two files “MOTIF ES-USB” and “MOTIF ES-USB_multi” appear. Copy 
these to the hard disk on your computer. 

5 Double-click on the “MOTIF ES-USB” or “MOTIF ES-USB_multi” file to 
start the OMS Setup. Each studio setup file is as follows. 

• MOTIF ES-USB
This is used when connecting a single MOTIF ES to the computer and 
using one port (up to 16 MIDI channels). 

• MOTIF ES-USB_multi
This is used when connecting several MOTIF ES’s to the computer and 
using up to eight ports (up to 128 MIDI channels). Note that one MOTIF 
ES can handle up to three ports (up to 48 MIDI channels). 

n Use of a USB hub is necessary when several MOTIF ESs are connected to the 
computer. 

n Be sure to select [MOTIF ES-USB_multi] when using the Remote Control function 
of the MOTIF via the USB cable, since Port 3 is used in this case. 

6 After starting the OMS Setup, the Studio setup file double-clicked in step #5 
opens. 

n If “ ” is not indicated at the right of the setup file name, select “Make Current” 
from the “File” menu and execute the save operation. 

The OMS studio setup has been completed.

n After the OMS studio setup above has been completed, your computer will 
recognize only the MOTIF as a MIDI instrument. If you use another MIDI 
instrument in addition to the MOTIF or you add a second MOTIF to the existing 
system, you should create an original Studio Setup file. For details, refer to the on-
line manual supplied with the OMS. 

n The included OMS studio setup file may not function even if you follow the above 
procedure, depending on your Macintosh/Mac OS version. (MIDI data cannot be 
transmitted/received even if the setup becomes available.) 
In this situation, connect your Macintosh to the MOTIF via the USB cable and 
follow the procedure below to re-create the setup file. 

1 Start OMS Setup and select “New Setup” from the “File” menu. 

2 The “OMS Driver Search” dialog appears. Remove the check from the “Modem” 
and “Printer” check boxes, and click [Search] to execute the device search. 
If the Search operation has been completed successfuly, the [USB-MIDI] device is 
displayed in the OMS driver setting dialog.

3 Click the [OK] button to search for ports. Port 1, Port 2 ... appears in the dialog. 
Mark the appropriate checkbox of the port and click the [OK] button to store the 
setting. 

For details about how to use OMS, refer to the relevant OMS 
documentation.

Indicates this setup is available

When opening “MOTIF ES-USB_multi”:
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For Windows/Macintosh Users
About USB Driver Setup window
From this window, you can change the MIDI port number transmitted to the MOTIF from the one set in the computer sequence software. 
For Windows, select [START] (→(Settings)) → [Control Panel] → [MIDI USB Driver] to open the driver setup window.
For Macintosh, select [Apple] menu → [Control Panels] → [YAMAHA USB MIDI Patch] to open the setup window.
The default settings are as follows. 

* This is actually the MIDI port number set from the [UTILITY] → [F5] MIDI → [SF4] OTHER display.

Port number MIDI OUT terminal 
(Thru Port number*)

MIDI IN terminal (Track 
Port number)

1 MIDI OUT (1) MIDI IN (1)

2 MIDI OUT (2) MIDI IN (2)

3 MIDI OUT (3) MIDI IN (3)

4 MIDI OUT (4) MIDI IN (4)

5 MIDI OUT (5) -

6 MIDI OUT (6) -

7 MIDI OUT (7) -

8 MIDI OUT (8) -
10   TOOLS for MOTIF ES6/MOTIF ES7/MOTIF ES8 Installation Guide
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Troubleshooting
The driver cannot be installed.

• Is the USB cable connected correctly?
→ Check the USB cable connection. 
→ Disconnect the USB cable, then connect it again.

Windows
• Is the USB function enabled on your computer?

→ When you connect the MOTIF to the computer for the first time, if the 
“Add New Hardware Wizard” does not appear, the USB function on the 
computer may be disabled. Perform the following steps. 

1 Select [Control Panel] → [System] → [Device Manager] (for Windows 
98/Me), or select [Control Panel]* → [System] → [Hardware] → 
[Device Manager] (for Windows 2000/XP).

* Classic View only in Windows XP.

2 Make sure that no “!” or “x” marks appear at “Universal serial bus 
controller” or “USB Root Hub.” If you see an “!” or “x” mark, the USB 
controller is disabled.

• Is any unknown device registered?
→ If driver installation fails, the MOTIF will be marked as an “Unknown 

device,” and you will not be able to install the driver. Delete the 
“Unknown device” by following the steps below.

1 Select [Control Panel] → [System] → [Device Manager] (for Windows 
98/Me), or select [Control Panel]* → [System] → [Hardware] → 
[Device Manager] (for Windows 2000/XP).

* Classic View only in Windows XP.

2 Look for “Other devices” in the menu “View devices by type.”

3 If you find “Other devices,” double-click it to extend the tree to look 
for “Unknown device.” If one appears, select it and click the [Remove] 
button.

4 Remove the USB cable from the MOTIF ES, and make the connection 
again.

5 Install the driver again. 

→ Windows 98/Me users......... see page 4

→ Windows 2000 users ........... see page 5

→ Windows XP users............... see page 5

When controlling the MOTIF from your computer via USB, the 
MOTIF does not operate correctly or no sound is heard.

• Did you install the driver?
• Is the USB cable connected correctly? 
• Are the volume settings of the tone generator, playback device, and 

application program set to the appropriate levels?
• Have you selected an appropriate port in the sequence software?
• Check whether the MIDI IN/OUT setting in the Utility mode corresponds to 

the actually used cable (USB or MIDI).

Playback response is delayed.

• Does your computer satisfy the system requirements? 
• Is any other application or device driver running?

Macintosh
→Turn off virtual memory.
→Disable AppleTalk.

Cannot suspend or resume the computer correctly.

• Do not suspend the computer while the MIDI application is running.
• If you are using Windows 2000, you may not be able to suspend/resume 

normally, depending on the particular environment (USB Host Controller, 
etc.). Even so, simply disconnecting and connecting the USB cable will allow 
you to use the MOTIF functions again.

How can I delete or re-install the driver?

Windows Me/98
1 When the MOTIF ES is recognized correctly, double-click “System” in the 

Control Panel to open the System window.

2 Double-click the “Device Manager” tab, select “YAMAHA USB MIDI 
Driver” and delete it.

3 Use the MS-DOS prompt or Explorer to delete the following three files. 

n To delete these files using Explorer, select “Folder Options” from the Tool (View) 
menu, and select “Show all files (and folders).”
• \WINDOWS\INF\OTHER\YAMAHAMOTIF6.INF
• \WINDOWS\SYSTEM\Xgusb.drv
• \WINDOWS\SYSTEM\Ymidusb.sys

4 Disconnect the USB cable.

5 Restart the computer.

6 Re-install the driver. 

Macintosh
1 Delete the files in the following locations:

• System Folder | Control Panels | YAMAHA USB MIDI Patch
• System Folder | Extensions | USB YAMAHA MIDI Driver
• System Folder | OMS Folder | YAMAHA USB MIDI OMS 
   Driver

2 Restart the computer.

3 Install the driver and set up OMS.
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Wichtige Hinweise zur CD-ROM
Datentypen
Diese CD-ROM enthält die Anwendungssoftware. Anweisungen zur Installation der Software finden Sie auf Seite 4 (für Windows) bzw. auf Seite 8 (für Macintosh). 

Versuchen Sie bitte niemals, diese CD-ROM auf einem Audio-CD-Spieler abzuspielen. Durch Mißachtung dieser Warnung können Sie nicht nur Ihrem 
CD-Spieler und Ihren Lautsprechern, sondern auch Ihrem Gehör Schaden zufügen. 

Medienformate
Der MOTIF ES6/MOTIF ES7/MOTIF ES8 ist mit folgenden Medienformaten kompatibel:
• MS-DOS    • CD-ROM mit ISO9660

Der MOTIF ES kann den Inhalt der mitgelieferten CD-ROM nicht direkt lesen. Die CD-ROM ist ausschließlich für die Verwendung mit einem Computer gedacht.

Falls eine Nur-Lese-Datei auf die im Card-Slot des MOTIF ES eingesteckte SmartMedia-Karte oder auf das am MOTIF ES angeschlossene USB-Speichergerät kopiert wird, kann sie nicht durch den 
MOTIF ES gelöscht werden.

Betriebssysteme
Die Anwendungen auf dieser CD-ROM werden in einer Version für Windows und in einer Version für das Macintosh-Betriebssystem bereitgestellt. Der 
Installationsvorgang und die Anwendungen für die beiden Betriebssysteme sind nicht identisch. Folgen Sie daher bitte der Ihrem Betriebssystem entsprechenden 
Installationsanleitung. 
Anweisungen zu Windows finden Sie auf Seite 4.
Anweisungen zum Macintosh-Betriebssystem finden Sie auf Seite 7.

Verfahren zur Installation der CD-ROM
Lesen Sie, bevor Sie das Siegel der Softwareverpackung öffnen, bitte die Software-Lizenzvereinbarung am Ende dieses Handbuchs sorgfältig durch.

1 Stellen Sie sicher, daß Ihr System die Betriebsanforderungen der Software (Voice Editor, Plug-in-Board-Editoren, Treiber usw.) erfüllt.

.........................................................................................................................................................................................................Windows: Seite 4; Macintosh: Seite 7

2 Installieren Sie auf dem Computer den entsprechenden Treiber, und nehmen Sie die erforderlichen Einstellungen vor. ...Windows: Seite 4; Macintosh: Seite 8

3 Installieren Sie die Software (Voice Editor usw.). .......................................................................................................................Windows: Seite 5; Macintosh: Seite 9

4 Starten Sie die Software.

Informationen zur weiteren Bedienung finden Sie in der Bedienungsanleitung des jeweiligen Softwareprogramms (Online-Hilfe/Handbuch als PDF-Datei).

Um PDF-Dateien anzeigen zu können, muß Acrobat Reader auf Ihrem Computer installiert sein (Windows: Seite 5; Macintosh: Seite 10).

Soforthilfe
• Ändern der Einstellungen für den MIDI-Port des USB-Treibers... Seite 10
• Der Treiber läßt sich nicht installieren ........................................... Seite 11
• Die Wiedergabe ist nicht korrekt ..................................................... Seite 11
• Wie läßt sich der Treiber entfernen oder neu installieren? ........... Seite 11

Für Windows-Benutzer
Inhalt der CD-ROM
Die CD-ROM enthält eine Reihe von Anwendungen (mit Installationsroutinen) und Daten in den folgenden Ordnern.

* Leider gibt Yamaha keine Garantie für die Stabilität dieser Programme (mit * gekennzeichnet) und kann den Anwendern auch keine technische Unterstützung dafür anbieten.
• Alle oben aufgeführten Anwendungen sind mit Online-Bedienungsanleitungen oder Bedienungsanleitungen im PDF-Format ausgestattet.
• Sie können die Software „Voice Editor für MOTIF ES6/7/8“ bzw. „Multi Part Editor für MOTIF ES6/7/8“ entweder als eigenständige Anwendung oder als Plug-In-Anwendung in einer mit der Open-

Plug-In-Technologie kompatiblen Anwendung starten. Weitere Informationen über die Verwendung des Voice Editors für MOTIF ES6/7/8 bzw. des Multi Part Editors für MOTIF ES6/7/8 als Plug-In-
Software finden Sie in der Bedienungsanleitung der Client-Anwendung (Sequencer usw.).

Name des Ordners Name der Anwendung Inhalt

Acroread_ Acrobat Reader* Anzeigeprogramm für PDF-Dateien (Portable Document Format). Hiermit können Sie die im PDF-Format 
vorliegenden Bedienungsanleitungen für die jeweiligen Anwendungen lesen.

Sq01_ SQ01 V2 Neue Version des SQ01 V2 mit umfassender Audio-Mixer-Funktion, mit der Sie am Computer eigene Songs 
erzeugen und wiedergeben können. Kann als Host-Anwendung für die Plug-In-Software verwendet werden.

AudioMixer_ (SQ01 V2) Plug-In-Software für den SQ01 V2, mit deren Hilfe Audiospuren gemischt werden können. (Kann nicht als 
eigenständige Anwendung verwendet werden.)

Twe_ YAMAHA Wave Editor TWE 2.4.4 Ermöglicht die Bearbeitung von Audiodaten (Wave-Daten) am Computer. 

Tools_ VEMOTES_ Voice Editor für MOTIF ES6/7/8 Ermöglicht die Bearbeitung der Voices des MOTIF ES am Computer.

MEMOTES_ Multi Part Editor für MOTIF ES6/7/8 Ermöglicht Ihnen, die Mixing-Parameter (wie z.B. die Effekte) des MOTIF ES an Ihrem Computer zu 
bearbeiten, wenn Sie den MOTIF ES als multitimbralen Klangerzeuger verwenden. 

USBdrv_ YAMAHA USB MIDI Driver (für Win98, Me) Ermöglicht die Kommunikation zwischen Computer und MOTIF ES, wenn diese über ein USB-Kabel 
miteinander verbunden sind.USBdrv2k_ YAMAHA USB MIDI Driver (für Win2000, XP)

NIdemo_ Demo-Songs für den Software-Synthesizer* Demo-Songs für den VST Plug-in-Software-Synthesizer von Native Instruments. 
Öffnen Sie den Ordner „NIdemo“, und doppelklicken Sie für die Plug-in-Software, die Sie installieren möchten, 
auf die entsprechende Datei „***Setup.exe“ (*** steht für den Dateinamen der Plug-in-Software). Folgen Sie 
anschließend den Anweisungen auf dem Bildschirm. 

DemoSong Song-Daten Demo-Songs für den SQ01 V2, wenn Sie den MOTIF ES als Klangerzeuger verwenden.
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Über die Open-Plug-In-Technologie
Sie können die Software „Voice Editor für MOTIF ES6/7/8“ bzw. „Multi Part Editor für MOTIF ES6/7/8“ entweder als eigenständige Anwendung oder als Plug-In-
Anwendung in einer mit der Open-Plug-In-Technologie kompatiblen Anwendung starten. Die „Open-Plug-In-Technologie“ (OPT) ist ein neu entwickeltes 
Softwareformat, das die Steuerung von MIDI-Geräten von einem Software-Sequencer aus ermöglicht. Sie können in diesem System zum Beispiel verschiedene 
Bereiche Ihres Musiksystems, z. B. Editoren für Plug-in-Board-Editoren und Mixer-Software, direkt von einem OPT-kompatiblen Sequencer aus starten und 
fernbedienen. Dadurch ist es nicht mehr erforderlich, MIDI-Treiber für jedes Programm einzustellen – Ihr Musikproduktionssystem ist einfacher und bequemer zu 
bedienen, alles greift nahtlos ineinander.

OPT-Levels – die Ebenen der Open-Plug-In-T echnologie
Die Client-Anwendung und deren Kompatibilität mit OPT kann wie folgend gezeigt in drei Levels eingeteilt werden.

Level 1 – OPT-Bedienfelder bieten eine einfache Unterstützung beim Öffnen und für die Darstellung von OPT-Bedienfeldern, die Daten über die 
externen MIDI-Ports des Client übertragen können. Diese Ebene ermöglicht normalerweise den vollwertigen Betrieb einfacher Bedienfelder von 
Hardwareeditoren.

Level 2 – OPT-Prozessoren bieten Unterstützung für MIDI-Berechnungen in Echtzeit und für die Automation von Bedienfeldern. Diese Ebene ermöglicht 
in der Regel ein ordnungsgemäßes Funktionieren von MIDI-Effekten (z.B. Arpeggiatoren, Transposern usw.) in Echtzeit oder offline sowie die 
Automatisierung von OPT-Bedienelementen. 

Level 3 – OPT Views bietet Unterstützung für Ansichten von Editoren und MIDI-Prozessoren/-Bedienelemente, die einen direkten Zugriff auf die 
Speicherstrukturen des Client-Sequencers benötigen. Diese Ebene ermöglicht in der Regel die Unterstützung ausgefeilter Ansichten von MIDI-Editoren (z.B. 
Listendarstellungen, automatische Begleitung, spezielle Editoren usw.).

Implementierung der OPT-Levels für den Voice-Editor
Diese Tabelle zeigt die OPT-Kompatibilität des Voice Editors für MOTIF ES6/7/8.

Bestimmte Funktionen arbeiten nicht erwartungsgemäß, wenn es in der Client-Anwendung (Sequencer usw.) keine entsprechende Funktion gibt. Die höchste Stufe der Implementierung 
(Level) für die Client-Anwendung ist am OPT-Logo zu erkennen, das zusammen mit der Versionsinformation im Programm angezeigt wird.

Implementierung der OPT-Levels für den Multi Part Editor
Die folgende Tabelle stellt die OPT-Kompatibilität des Multi Part Editor für MOTIF6/7/8 dar.

Wenn Sie den Multi Part Editor für MOTIF ES6/7/8 als Plug-In innerhalb von Level 2 (Prozessoren) und Level 3 (Ansichten) von Host-Anwendungen einsetzen, 
können alle Funktionen genutzt werden. Einige Host-Anwendungen unterstützen keine Fernbedienung.

Bestimmte Funktionen arbeiten nicht erwartungsgemäß, wenn es in der Client-Anwendung (Sequencer usw.) keine entsprechende Funktion gibt. Die höchste Stufe der Implementierung 
(Level) für die Client-Anwendung ist am OPT-Logo zu erkennen, das zusammen mit der Versionsinformation im Programm angezeigt wird.

OPT-Levels der Client-Anwendung
Voice Editor für den Betrieb mit dem MOTIF ES6/7/8

Funktionsunterstützung Funktionseinschränkungen

VIEWS (Level 3)             Ja Keine

PROCESSORS (Level 2) Ja Keine

PANELS (Level 1)          Ja (mit Einschränkungen) Empfang von Blockdaten

OPT-Levels der Client-Anwendung
Multi Part Editor für den Betrieb mit dem MOTIF ES6/7/8

Funktionsunterstützung Funktionseinschränkungen

VIEWS (Level 3)             Ja Keine

PROCESSORS (Level 2) Ja Keine

PANELS (Level 1)          Ja Empfang von Blockdaten
TOOLS for MOTIF ES6/MOTIF ES7/MOTIF ES8 Installationshandbuch   3
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System-Mindestanforderungen
Die nachfolgend angegebenen Systemanforderungen können je nach 
Betriebsystem geringfügig abweichen.

• SQ01 V2
OS: Windows 98/Me/2000/XP Home Edition/

XP Professional
Computer: Mindestens 500 MHz; Intel Pentium/

Celeron-Prozessor (bei Verwendung von XP
mindestens 750 MHz)

Verfügbarer Arbeitsspeicher: 256 MB oder mehr
Benötigter Festplattenspeicher: 300 MB oder mehr
Bildschirmauflösung: 1024 x 768 Pixel oder mehr

• Voice Editor für MOTIF ES6/7/8
Betriebssystem: Windows 95/98/Me/2000/

XP Home Edition/XP Professional
Computer: Mindestens 166 MHz;

Intel Pentium/Celeron-Prozessor
Verfügbarer Arbeitsspeicher: 32 MB oder mehr
Benötigter Festplattenspeicher: 24 MB oder mehr
Bildschirmauflösung: 640 x 480, High Color (16 Bit) oder darüber

• Multi Part Editor für MOTIF ES6/7/8
Betriebssystem: Windows 98/Me/2000/XP Home Edition/

XP Professional
Computer: Mindestens 166 MHz;

Intel Pentium/Celeron-Prozessor
Verfügbarer Arbeitsspeicher: 32 MB oder mehr
Benötigter Festplattenspeicher: 32 MB oder mehr
Bildschirmauflösung: 1024 x 768, High Color (16 Bit) oder darüber

• TWE V2.4.4
Betriebssystem: Windows 95/98/Me/2000/NT/XP
Computer: Mindestens 166 MHz;

Intel Pentium/Celeron-Prozessor
Verfügbarer Arbeitsspeicher: 24 MB oder mehr
Benötigter Festplattenspeicher: Durchschnittliche Zugriffszeit 30 ms 

oder weniger
Bildschirmauflösung: 800 x 600, 256 Farben oder mehr

• USB MIDI Driver 
Betriebssystem: Windows 98/Me/2000/XP Home Edition/

XP Professional
Computer: Mindestens166 MHz;

Intel Pentium/Celeron-Prozessor
Verfügbarer Arbeitsspeicher: 32 MB oder mehr

(64 MB oder mehr werden empfohlen)
Benötigter Festplattenspeicher: 2 MB oder mehr

Die vorstehend beschriebenen System-Mindestanforderungen gelten ab Juni 2003. 
Beachten Sie, daß die Software häufig aktualisiert wird und die Systemanforderungen 
geändert werden können. Informationen über die neueste Version der jeweiligen 
Programme und ihre Systemanforderungen finden Sie auf der folgenden Website. 
http://www.yamaha.co.jp/product/syndtm/index.html

Softwareinstallation

Deinstallieren (installierte Anwendung entfernen)
Um die installierte Anwendungssoftware zu entfernen: 
Wählen Sie den Befehlspfad � [START] � [Einstellungen] � 
[Systemsteuerung] � [Software] � [Installieren/Deinstallieren], 
markieren Sie die zu entfernende Anwendung, und klicken Sie auf 
[Hinzufügen/Entfernen…]. 
Befolgen Sie die Anweisungen auf dem Bildschirm zur Deinstallation 
der Anwendung.

Je nach Betriebssystem können die Namen von Schaltflächen oder Menüs anders 
lauten.

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •  
Acrobat Reader

 
Um die elektronischen Handbücher (im PDF-Format) der einzelnen 
Anwendungen anzeigen zu können, müssen Sie Acrobat Reader installieren.

 

Wenn bereits eine ältere Version des Acrobat Reader auf Ihrem PC installiert ist, müssen 
Sie diese vorher deinstallieren.

1 Doppelklicken Sie auf den Ordner „Acroread_“. 
Daraufhin werden Ordner für vier verschiedene Sprachen angezeigt.

2 Wählen Sie die zu verwendende Sprache aus, und doppelklicken Sie auf den 
entsprechenden Ordner. 
Die Datei „ar***.exe“ wird angezeigt. („***“ steht für die ausgewählte 
Sprache.)

3 Doppelklicken Sie auf „ar***.exe“.
Das Dialogfenster „Acrobat Reader Setup“ wird angezeigt.

4 Führen Sie die Installation aus, indem Sie den Anweisungen auf dem 
Bildschirm folgen.

Nach erfolgreicher Installation befindet sich der Acrobat-Ordner auf Ihrem PC 
(standardmäßig unter „Programme“).
Informationen zur Verwendung von Acrobat Reader erhalten Sie, indem Sie im 
Menü [Hilfe] auf [Reader Guide] klicken.

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •
USB MIDI Driver
Um den MOTIF ES über USB von einem Computer aus bedienen zu können, 
müssen Sie zunächst die geeignete Treibersoftware (englisch: Driver) 
installieren.
Der USB MIDI Driver ist eine Software, die MIDI-Daten über ein USB-Kabel 
zwischen einer Sequencer-Software und dem MOTIF ES überträgt.

Für Windows 98/Me: Siehe unten.
Für Windows 2000: Siehe Seite 5.
Für Windows XP: Siehe Seite 5. 

� Installation des Treibers unter Windows 98/Me
1 Starten Sie den Computer.

2 Legen Sie die mitgelieferte CD-ROM in das CD-ROM-Laufwerk ein.

3 Vergewissern Sie sich zunächst, daß der Netzschalter [POWER] am MOTIF 
ES auf OFF (Aus) gestellt ist, und verwenden Sie dann ein USB-Kabel, um 
die USB-Schnittstelle des Computers (oder des USB-Hubs) mit der USB-TO-
HOST-Buchse des MOTIF ES zu verbinden. Sobald der MOTIF ES 
eingeschaltet wird, wird auf dem Computer automatisch der „Hardware-
Assistent“ angezeigt. Falls der Hardware-Assistent nicht automatisch 
erscheint, klicken Sie in der Systemsteuerung auf [Hardware].

Für WindowsMe-Benutzer: Wählen Sie die Option „Automatisch nach dem besten 
Treiber suchen (empfohlen)“ aus, und klicken Sie auf [Weiter]. Die Suche nach 
dem Treiber und die Installation des Treibers werden automatisch gestartet. Fahren 
Sie mit Schritt 8 fort. Falls das System den Treiber nicht findet, wählen Sie zum 
Installieren des Treibers die Option „Position des Treibers angeben (Erweitert)“ 
aus, und geben Sie den Ordner „USBdrv_“ auf dem CD-ROM-Laufwerk an. 

4 Klicken Sie auf [Weiter].
Das Fenster ermöglicht Ihnen die Auswahl der Suchmethode.

5 Aktivieren Sie bitte die Option „Nach einem besseren als dem derzeit 
verwendeten Treiber suchen (Empfohlen)“. Klicken Sie auf [Weiter]. Das 
Fenster ermöglicht Ihnen die Angabe des Ordners, in dem der Treiber 
installiert werden soll.

6 Wenn Sie Windows 98 verwenden, markieren Sie das Kontrollfeld 
„Dateipfad festlegen“, und klicken Sie auf „Durchsuchen...“. Geben Sie 
anschließend das Verzeichnis „USBdrv“ auf dem CD-ROM-Laufwerk an 
(beispielsweise „D:\USBdrv_\“), und setzen Sie die Installation fort. 

Wenn Sie Windows Me verwenden, markieren Sie das Kontrollfeld 
„CD-ROM drive“ (CD-ROM-Laufwerk), und entfernen Sie alle übrigen 
Häkchen. Klicken Sie auf [Weiter].

Wenn Sie Windows Me verwenden, fordert das System Sie möglicherweise 
während der Treibersuche auf, die Windows CD-ROM einzulegen. Geben Sie das 
Verzeichnis „USBdrv“ auf dem CD-ROM-Laufwerk an (beispielsweise 
„D:\USBdrv_\“), und setzen Sie die Installation fort.

7 Sobald das System den Treiber auf der CD-ROM gefunden hat und zur 
Installation bereit ist, wird dies in einer Bildschirmmeldung angezeigt.
Vergewissern Sie sich, daß der „YAMAHA USB MIDI Driver“ aufgeführt 
ist, und klicken Sie auf [Weiter]. Die Installation wird gestartet.

8 Sobald die Installation abgeschlossen ist, erscheint eine entsprechende 
Meldung.
Klicken Sie auf [Fertig stellen].

Bei einigen Computern kann es etwa zehn Sekunden dauern, bis dieses Fenster 
nach Beendigung der Installation angezeigt wird.

Der Treiber wurde installiert.

Computer

MOTIF ES

USB-Kabel

Treiber

Sequenzer-
programm
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� Installation des Treibers unter Windows 2000

1 Starten Sie den Computer, und melden Sie sich über das „Administrator“-
Konto in Windows 2000 an.

2 Wählen Sie den Befehlspfad, [Arbeitsplatz | Systemsteuerung | System | 
Hardware | Treibersignierung | Dateisignaturverifizierung], kreuzen Sie die 
Option „Ignorieren - Alle Dateien installieren, unabhängig von der 
Dateisignatur“ an, und klicken Sie auf [OK].

3 Legen Sie die mitgelieferte CD-ROM in das CD-ROM-Laufwerk ein.

4 Vergewissern Sie sich zunächst, daß der Netzschalter [POWER] am MOTIF 
ES auf OFF (Aus) gestellt ist, und verwenden Sie dann ein USB-Kabel, um 
die USB-Schnittstelle des Computers (oder des USB-Hubs) mit der USB-TO-
HOST-Buchse des MOTIF ES zu verbinden. Sobald der MOTIF ES 
eingeschaltet wird, wird auf dem Computer der „Assistent für das Suchen 
neuer Hardware“ angezeigt. Klicken Sie auf [Weiter].

5 Aktivieren Sie bitte die Option „Nach dem besten Treiber für das Gerät 
suchen (Empfohlen)“. Klicken Sie auf [Weiter].
Im daraufhin angezeigten Fenster können Sie einen Speicherort angeben, 
an dem nach dem Treiber gesucht werden soll.

6 Aktivieren Sie das Kästchen neben „CD-ROM-Laufwerk“, und deaktivieren 
Sie alle anderen Kästchen. Klicken Sie auf [Weiter].

Während der Suche nach dem Treiber fordert das System Sie u.U. auf, eine 
Windows-CD-ROM einzulegen. Geben Sie das Verzeichnis „USBdrv_“ auf dem 
CD-ROM-Laufwerk an (also beispielsweise „D:\USBdrv2k_\“), und setzen Sie die 
Installation fort.

7 Nach Beendigung der Installation wird die Meldung „Fertig stellen des 
Assistenten“ angezeigt. Klicken Sie auf [Fertig stellen].

Bei einigen Computern kann es etwa zehn Sekunden dauern, bis dieses Fenster 
nach Beendigung der Installation angezeigt wird. 

8 Starten Sie den Computer neu. 
Der Treiber wurde installiert.

� Installieren des Treibers unter Windows XP

1 Starten Sie den Computer.

2 Wählen Sie den Befehlspfad [Start] � [Systemsteuerung].
Falls im rechten Fenster der Systemsteuerung „Wählen Sie eine Kategorie“ 
angezeigt ist, klicken Sie oben links im Fenster auf „Zur klassischen 
Ansicht wechseln“.
Es werden alle Kontrollfelder und Symbole angezeigt.

3 Wählen Sie den Befehlspfad [System] � [Hardware] � [Treibersignierung] 
� [Dateisignaturverifizierung], krezuen Sie die Option „Ignorieren – Alle 
Dateien installieren, unabhängig von der Dateisignatur“ an, und klicken Sie 
auf [OK].

4 Klicken Sie auf [OK], um das Fenster „Eigenschaften von System“ zu 
schließen, und klicken Sie dann oben rechts im Fenster auf die Schaltfläche 
„X“, um die Systemsteuerung zu schließen.

5 Legen Sie die mitgelieferte CD-ROM in das CD-ROM-Laufwerk ein.

6 Vergewissern Sie sich zunächst, daß der Netzschalter [POWER] am MOTIF 
ES auf OFF (Aus) gestellt ist, und verwenden Sie dann ein USB-Kabel, um 
die USB-Schnittstelle des Computers (oder des USB-Hubs) mit der USB-TO-
HOST-Buchse des MOTIF ES zu verbinden. Sobald das MOTIF ES 
eingeschaltet wird, wird auf dem Computer der „Assistent für das Suchen 
neuer Hardware“ angezeigt.

Bei einigen Computern kann es ein paar Minuten dauern, bis dieses Fenster 
angezeigt wird.

7 Aktivieren Sie bitte die Option „Nach dem besten Treiber für das Gerät 
suchen (Empfohlen)“. Klicken Sie auf [Weiter].
Die Installation wird gestartet.

8 Nach Beendigung der Installation wird die Meldung „Fertig stellen des 
Assistenten“ angezeigt. Klicken Sie auf [Fertig stellen].

Bei einigen Computern kann es ein paar Minuten dauern, bis nach Beendigung der 
Installation dieses Fenster angezeigt wird.

9 Starten Sie den Computer neu.
Der Treiber wurde installiert.

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •
SQ01 V2
Bei der Installation des SQ01 V2 können Sie auch den Voice Editor für 
MOTIF ES 6/7/8, den Multi Part Editor für MOTIF ES 6/7/8 und den Wave 
Editor TWE zusammen als Plug-In-Software des SQ01 V2 installieren. 

1 Doppelklicken Sie auf das Verzeichnis „SQ01_“. 
Daraufhin werden mehrere Dateien angezeigt, unter anderem „Setup.exe“.

2 Doppelklicken Sie auf „Setup.exe“.
Das Dialogfenster „SQ01 Setup“ wird angezeigt.

3 Führen Sie die Installation aus, indem Sie den Anweisungen auf dem 
Bildschirm folgen.
Klicken Sie nach der Installation auf [Restart] (Neustart). Nach dem 
Neustart von Windows befindet sich auf Ihrem PC der Ordner „YAMAHA“ 
(standardmäßig im Ordner „Programme“) mit dem Unterordner „SQ01“.
Informationen zur Bedienung der Anwendung finden Sie in der Online-Hilfe.

Einrichtung des SQ01 V2 für MIDI
1 Starten Sie den SQ01 V2.

Klicken Sie im Menü [Start] auf [Programme] und dann auf 
[YAMAHA SQ01 Ver 2.0] � [SQ01].

2 Klicken Sie im Menü [Setup] (Spurfenster) auf [MIDI], und wählen 
Sie [MIDI] � [Device], um die Seite „Device“ (Gerät) des 
Dialogfensters „MIDI“ aufzurufen.

3 Wählen Sie im Feld [OUT] den passenden Ausgangsport zur 
Verwendung der USB-Verbindung mit dem MOTIF ES aus 
(beispielsweise „YAMAHA USB OUT 0-1“).

4 Wählen Sie im Feld [IN] den entsprechenden Eingangsport aus 
(beispielsweise „YAMAHA USB IN 0-1“), und klicken Sie auf [OK], 
um das Dialogfenster zu schließen.

Falls erforderlich, können Sie den Audiotreiber und das Gerät für die 
Audioeingabe/-ausgabe auswählen. Klicken Sie im Menü [Setup] auf [Audio] � 
[Device], um die Seite „Device“ (Gerät) des Dialogfensters „Audio“ aufzurufen.

Die USB-Verbindung mit dem MOTIF ES kann nur für die Übertragung von MIDI-
Daten verwendet werden. Über USB können keine Audiodaten übertragen werden. 

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •
Voice Editor und Multi Part Editor
Sobald Sie diese Softwareprogramme installiert haben, können Sie die Voices 
und Mixing-Einstellungen des MOTIF ES am Computer bearbeiten.

1 Doppelklicken Sie auf das Verzeichnis „Tools“ der CD-ROM. 
Die Ordner „VEMOTES_“ und „MEMOTES_“ werden angezeigt. 

2 Doppelklicken Sie auf den Ordner „VEMOTES_“ bzw. den Ordner 
„MEMOTES_“. 
Die Datei „Setup.exe“ wird angezeigt. 

3 Doppelklicken Sie auf die Datei „setup.exe“. 
Das Dialogfenster für das Tool-Setup des Voice Editors bzw. des Multi Part 
Editors wird angezeigt. 

4 Führen Sie die Installation aus, indem Sie den Anweisungen auf dem 
Bildschirm folgen. 

Einzelheiten hierzu finden Sie in der Online-Hilfe dem PDF-Handbuch der 
jeweiligen Software. 

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •
TWE (als eigenständige Anwendung)
Bei der Installation des SQ01 V2 können Sie auch den TWE, mit dem Sie die 
Wave-Daten direkt am Computer bearbeiten können, als Plug-In-Software des 
SQ01 V2 installieren. Wenn Sie den TWE als eigenständige Anwendung 
installieren möchten, folgen Sie bitte den nachstehenden Anweisungen.

1 Doppelklicken Sie auf das Verzeichnis „Twe_“. 

2 Wählen Sie die gewünschte Sprache aus, und doppelklicken Sie auf 
„setup.exe“. 

3 Führen Sie die Installation aus, indem Sie den Anweisungen auf dem 
Bildschirm folgen. 
Informationen zur Bedienung finden Sie in der Bedienungsanleitung im 
PDF-Format, die sich ebenfalls im Verzeichnis befindet. 
TOOLS for MOTIF ES6/MOTIF ES7/MOTIF ES8 Installationshandbuch   5
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MIDI-Port-Einstellungen
(bei Ausführung der Software als 
eigenständige Anwendung)
Bevor Sie im Voice Editor oder im Multi Part Editor den MIDI-Port einstellen, 
müssen Sie den MIDI-Port über [MIDI SETUP] in der Symbolleiste festlegen. 

Wenn Sie den Voice Editor oder den Multi Part Editor innerhalb eines zur Open-Plug-in-
Technologie kompatiblen Programms als Plug-In starten, lesen Sie bitte das PDF-
Handbuch des entsprechenden Programms.

1 Starten Sie den Voice Editor bzw. den Multi Part Editor. 

2 Klicken Sie in der in Schritt 1 aufgerufenen Symbolleiste auf die Schaltfläche 
[MIDI Setup]. 

3 Klicken Sie im in Schritt 2 aufgerufenen Fenster „MIDI Setup“ in allen 
Feldern rechts auf die Schaltfläche [�], und nehmen Sie die in der 
folgenden Abbildung angezeigten Port-Einstellungen vor:

Damit MIDI-Ports hier zur Verfügung stehen, müssen Sie den entsprechenden 
MIDI-Port innerhalb der einzelnen Anwendungen auswählen (Voice Editor oder 
Multi Part Editor). Das ist der Port, den Sie in den verschiedenen Softwares 
anwenden werden. Weitere Informationen zur Festlegung des MIDI-Ports finden 
Sie in der Online-Hilfe der jeweiligen Software. 

Schaltfläche [MIDI Setup]
6   TOOLS for MOTIF ES6/MOTIF ES7/MOTIF ES8 Installationshandbuch
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Für Macintosh-Benutzer
Inhalt der CD-ROM
Die CD-ROM enthält zwei Ordner: „International“ und „Japanese“. Doppelklicken Sie auf den Ordner „International“, um ihn zu öffnen. In den folgenden 
Verzeichnissen befinden sich mehrere Anwendungen (mit Installationsroutinen) und Daten.

* Leider gibt Yamaha keine Garantie für die Stabilität dieser Programme (mit * gekennzeichnet) und kann den Anwendern auch keine technische 
Unterstützung dafür anbieten.

• Alle oben aufgeführten Anwendungen sind mit Online-Bedienungsanleitungen oder Bedienungsanleitungen im PDF-Format ausgestattet.

System-Mindestanforderungen
Die nachfolgend angegebenen Systemanforderungen können je nach Betriebsystem geringfügig abweichen.

• Voice Editor für MOTIF ES6/7/8
Betriebssystem: Mac OS 8.6 bis Mac OS 9.22 (Die Umgebungen Mac OS X und Mac Classic werden nicht unterstützt.)
Computer: Ein Macintosh-Computer mit einer PowerPC- oder höheren CPU
Verfügbarer Arbeitsspeicher: 18 MB oder mehr
Benötigter Festplattenspeicher: 64 MB oder mehr
Bildschirmauflösung: 800 x 600, 32.000 Farben oder mehr

• TWE V2.3
Betriebssystem: Mac OS 7.6.1 bis Mac OS 9.22 (Die Umgebungen Mac OS X und Mac Classic werden nicht unterstützt.)
Computer: Ein Macintosh-Computer mit einer PowerPC- oder höheren CPU
Verfügbarer Arbeitsspeicher: 8 MB oder mehr
Benötigter Festplattenspeicher: Durchschnittliche Zugriffszeit 30 ms oder weniger
Bildschirmauflösung: 640 x 400, 256 Farben oder mehr

• USB MIDI Driver 
Betriebssystem: Mac OS 8.6 bis Mac OS 9.22 (Die Umgebungen Mac OS X und Mac Classic werden nicht unterstützt.)
Computer: Ein Macintosh-Computer mit einer USB-Schnittstelle und einer PowerPC- oder höheren CPU
Arbeitsspeicher: Mindestens 64 MB (mindestens 128 MB werden empfohlen)

Schalten Sie den virtuellen Speicher ab.

Benötigter Festplattenspeicher: 2 MB oder mehr
Sonstige: OMS 2.3.8 (auf der mitgelieferten CD-ROM enthalten)

Die vorstehend beschriebenen System-Mindestanforderungen gelten ab Juni 2003. 
Beachten Sie, daß die Software häufig aktualisiert wird und die Systemanforderungen geändert werden können.  
Informationen über die neueste Version der jeweiligen Programme und ihre Systemanforderungen finden Sie auf der folgenden Website. 
http://www.yamaha.co.jp/product/syndtm/index.html

Name des Ordners Name der Anwendung Inhalt
Acroread_ Acrobat Reader* Anzeigeprogramm für PDF-Dateien (Portable Document Format). Hiermit können Sie die im 

PDF-Format vorliegenden Bedienungsanleitungen für die jeweiligen Anwendungen lesen.

OMS_ OMS Open Music System (OMS)* Ermöglicht die Verwendung mehrerer MIDI-Anwendungen auf dem Mac OS.

OMS Setup OMS Setup for YAMAHA Enthält die OMS Setup-Dateien für Yamaha-Klangerzeuger.

USBdrv_ YAMAHA USB MIDI Driver Ermöglicht die Kommunikation zwischen Computer und MOTIF ES, wenn diese über ein 
USB-Kabel miteinander verbunden sind.

VEMOTES_ Voice Editor für MOTIF ES6/7/8 Ermöglicht die Bearbeitung der Voices des MOTIF ES am Computer.

Twe_ YAMAHA Wave Editor TWE 2.3 Ermöglicht die Bearbeitung von Audiodaten (Wave-Daten) am Computer. 

NIdemo_ Demo-Songs für den Software-Synthesizer* Demo-Songs für den VST Plug-in-Software-Synthesizer von Native Instruments.
Öffnen Sie den Ordner „NIdemo“, und doppelklicken Sie für die Plug-in-Software, die Sie 
installieren möchten, auf die entsprechende Datei „***Demo Install/installer“ (*** steht für 
den Dateinamen der Plug-in-Software). Folgen Sie anschließend den Anweisungen auf dem 
Bildschirm. 
TOOLS for MOTIF ES6/MOTIF ES7/MOTIF ES8 Installationshandbuch   7
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• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •  
Acrobat Reader

 
Um die elektronischen Handbücher (im PDF-Format) der einzelnen 
Anwendungen anzeigen zu können, müssen Sie Acrobat Reader installieren. 

1 Doppelklicken Sie auf den Ordner „Acroread_“.
Daraufhin werden Ordner für drei verschiedene Sprachen angezeigt: 
„English“, „German“ und „French“.

2 Wählen Sie die zu verwendende Sprache aus, und doppelklicken Sie auf den 
entsprechenden Ordner.
Der „Reader Installer“ wird angezeigt.
Der Name des Installationsprogramms kann je nach ausgewählter Sprache 
variieren.

3 Doppelklicken Sie auf den „Reader Installer“.
Das Dialogfenster „Acrobat Reader Setup“ wird angezeigt.

4 Führen Sie die Installation aus, indem Sie den Anweisungen auf dem 
Bildschirm folgen.
Nach erfolgreicher Installation befindet sich auf Ihrem Mac der Acrobat-
Ordner (standardmäßig auf dem Startvolume).
Informationen zur Verwendung von Acrobat Reader erhalten Sie, indem Sie 
im Menü [Hilfe] auf [Reader Guide] klicken.

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •  
Open Music System (OMS) 2.3.8

 
OMS ermöglicht Ihnen unter MacOS den gleichzeitigen Betrieb mehrerer 
MIDI-Anwendungen.

1 Doppelklicken Sie auf das Verzeichnis „OMS“ (nur in der englischen 
Version verfügbar).
„Install OMS 2.3.8“ wird angezeigt.

2 Doppelklicken Sie auf „Install OMS 2.3.8“.
Das Dialogfenster „OMS Setup“ wird angezeigt.

3 Führen Sie die Installation aus, indem Sie den Anweisungen auf dem 
Bildschirm folgen. 
Klicken Sie nach der Installation auf [Restart] (Neustart).

Nach Beendigung der Installation wird u.U. eine Fehlermeldung angezeigt, die 
darauf hinweist, daß das Installationsprogramm nicht geschlossen wurde. Wechseln 
Sie in diesem Fall in das Menü [File] (Datei), und wählen Sie [Quit] (Beenden) aus, 
um das Installationsprogramm zu beenden. Starten Sie dann den Computer neu.

Nach dem Neustart des Macintosh finden Sie auf Ihrem Computer das 
Verzeichnis „Opcode“/„OMS Applications“ (standardmäßig auf dem 
Startvolume).

4 Kopieren Sie die Datei „OMS_2.3_Mac.pdf“ von der CD-ROM in den 
Ordner „OMS Applications“ (ziehen Sie die Datei einfach auf den Ordner).
In der Datei „OMS_2.3_Mac.pdf“ (nur auf Englisch verfügbar) finden Sie 
Informationen zur Verwendung des Programms.

5 Kopieren Sie die Datei „OMS Setup for Yamaha“ von der CD-ROM in den 
Ordner „OMS Applications“ (ziehen Sie die Datei einfach auf den Ordner).
Im Verzeichnis „OMS Setup for Yamaha“ finden Sie die OMS-Setup-Dateien 
für die Yamaha-Klangerzeuger, die als Vorlagen verwendet werden können.

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •  
USB MIDI Driver

 
Um den MOTIF ES über USB von einem Computer aus bedienen zu können, 
müssen Sie zunächst die geeignete Treibersoftware (englisch: Driver) 
installieren.
Der USB MIDI Driver ist eine Software, die MIDI-Daten über ein USB-Kabel 
zwischen einer Sequencer-Software und dem MOTIF ES überträgt.

Installieren Sie vor der Installation des USB-MIDI-Treibers zuerst OMS. Nach 
der Installation des Treibers müssen Sie OMS noch einrichten (siehe oben).

1 Starten Sie den Computer.

2 Legen Sie die mitgelieferte CD-ROM in das CD-ROM-Laufwerk ein. Das 
System zeigt auf dem Desktop das CD-ROM-Symbol an.

3 Doppelklicken Sie zunächst auf das CD-ROM-Symbol und anschließend im 
Ordner „USBdrv_“ auf das Symbol „Install USB Driver“ (USB-Treiber 
installieren), um das folgende Installationsfenster zu öffnen. 

4 Das Feld „Install Location“ zeigt den Zielordner der Installation an. Wenn 
Sie Ziellaufwerk oder den Zielordner ändern möchten, klicken Sie auf die 
Schaltfläche [Switch Disk] (Laufwerk wechseln), und geben Sie im Pop-Up-
Menü das gewünschte Ziel an.

Normalerweise wird in diesem Feld das Startvolume als Zielverzeichnis angezeigt.

5 Klicken Sie auf die Schaltfläche [Install]. Das System zeigt eine Meldung an, 
die Sie auffordert, den Computer neu zu starten. Klicken Sie auf [Continue] 
(Fortfahren), um alle anderen Anwendungen zu schließen und den 
Computer neu zu starten.

Um die Installation abzubrechen, klicken Sie auf [Cancel] (Abbrechen).

6 Die Installation beginnt. Falls der Treiber schon installiert ist, wird die 
folgende Meldung angezeigt. Klicken Sie auf [Continue], um zu Schritt 3 
zurückzukehren. Um die Installation zu beenden, klicken Sie auf [Quit].

7 Wenn die Installation abgeschlossen ist, zeigt das System eine Meldung auf, 
die Sie auffordert, den Computer neu zu starten. Klicken Sie auf [Restart] 
(Neu starten). Der Computer wird neu gestartet. Die installierten Dateien 
befinden sich in den folgenden Ordnern:

• Systemordner | Kontrollfelder | YAMAHA USB MIDI Patch
• Systemordner | Systemerweiterungen | USB YAMAHA MIDI Driver
• System Folder | OMS Folder | YAMAHA USB MIDI OMS Driver

Computer

Sequenzer-
programm

OMS Treiber

USB-Kabel

MOTIF ES
8   TOOLS for MOTIF ES6/MOTIF ES7/MOTIF ES8 Installationshandbuch



  

      

                         

D
eu

ts
ch
• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •  
Voice Editor

 
Sobald Sie diese Softwareprogramme installiert haben, können Sie die Voices 
und Mixing-Einstellungen des MOTIF ES an Ihrem Computer bearbeiten. 

1 Doppelklicken Sie auf das Verzeichnis „International“ der CD-ROM. 
Der Ordner „VEMOTES_“ wird angezeigt. 

2 Doppelklicken Sie auf das Verzeichnis „VEMOTES_“. 
„Install VoiceEditorFor MOTIF ES“ (Voice Editor für MOTIF ES 
installieren) wird angezeigt. 

3 Doppelklicken Sie auf die Datei „Install VoiceEditorFor MOTIF ES“. Das 
Dialogfenster zur Installation des Voice Editors wird angezeigt. Führen Sie 
die Installation aus, indem Sie den Anweisungen auf dem Bildschirm folgen. 

4 Starten Sie den Computer nach der Installation neu. 

Weitere Informationen finden Sie in der Online-Hilfe oder in der 
Bedienungsanleitung im PDF-Format. 

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •  
TWE

 
Mit der Audiobearbeitungs-Software TWE können Sie Wave-Daten direkt am 
Computer bearbeiten.

1 Doppelklicken Sie auf das Verzeichnis „TWE“. 
Daraufhin werden Ordner für vier verschiedene Sprachen angezeigt. 

2 Wählen Sie die Sprache aus, die Sie nutzen möchten, indem Sie auf das 
entsprechende Verzeichnis doppelklicken. 
Das Verzeichnis „YAMAHA TWE“ wird angezeigt. 

3 Kopieren Sie das Verzeichnis „YAMAHA TWE“ auf die Festplatte Ihres 
Computers. 
Informationen über die Verwendung des TWE finden Sie im Online-
Handbuch, das sich im TWE-Verzeichnis befindet.

OMS einrichten
Die OMS-Studio-Setup-Datei für den MOTIF ES ist auf der mitgelieferten 
CD-ROM enthalten. Diese Studio-Setup-Datei wird benötigt, um OMS 
einzurichten. 

Bevor Sie die folgende Prozedur durchführen, sollten OMS und der USB MIDI Driver 
installiert sein. 

1 Verwenden Sie das USB-Kabel, um die USB-Schnittstelle des Computers 
(oder des USB-Hubs) mit der USB-Schnittstelle des MOTIF ES zu 
verbinden, und schalten Sie den MOTIF ES ein. 

2 Starten Sie den Computer. 

3 Legen Sie die mitgelieferte CD-ROM in das CD-ROM-Laufwerk Ihres 
Macintosh ein. Auf dem Desktop wird das CD-ROM-Symbol angezeigt. 

4 Doppelklicken Sie nacheinander auf das CD-ROM-Symbol, „International“, 
„OMS“ und „OMS Setup for YAMAHA“. Die beiden Dateien „MOTIF ES-
USB“ und „MOTIF ES-USB_multi“ werden angezeigt. Kopieren Sie diese 
Datei auf die Festplatte des Computers. 

5 Doppelklicken Sie auf die Datei „MOTIF ES-USB“ bzw. „MOTIF ES-
USB_multi“, um das OMS-Setup zu starten. Alle Studio-Setup-Dateien 
funktionieren wie folgt. 

• MOTIF ES-USB
Diese Datei sollten Sie verwenden, wenn Sie einen einzelnen MOTIF ES 
an den Computer anschließen und einen Port (bis zu 16 MIDI-Kanäle) 
nutzen möchten. 

• MOTIF ES-USB_multi
Diese Datei sollten Sie verwenden, wenn Sie mehrere MOTIF ES an den 
Computer anschließen und bis zu acht Ports (bis zu 128 MIDI-Kanäle) 
nutzen möchten. Beachten Sie, daß ein MOTIF ES bis zu drei Ports 
verarbeiten kann (bis zu 48 MIDI-Kanäle). 

Wenn Sie mehrere MOTIF ES an den Computer anschließen möchten, müssen Sie 
einen USB-Hub verwenden. 

Wenn Sie die Remote-Control-Funktion des MOTIF über das USB-Kabel 
verwenden, achten Sie bitte darauf, die Option [MOTIF ES-USB_multi] 
auszuwählen, da in diesem Fall Port 3 verwendet wird. 

6 Nachdem das OMS-Setup gestartet wurde, wird die in Schritt 5 doppelt 
angeklickte Studio-Setup-Datei geöffnet. 

Falls rechts neben dem Namen der Installationsdatei nicht „ “ angezeigt wird, 
wählen Sie im Menü [File] (Datei) die Option [Make Current] (zur aktuellen 
Installation machen), und führen Sie den Speichervorgang aus. 

Das OMS-Studio-Setup ist abgeschlossen.

Nachdem Sie mit den obigen Anweisungen das OMS Studio eingerichtet haben, 
erkennt Ihr Computer nur den MOTIF als MIDI-Instrument. Wenn Sie zusätzlich 
zum MOTIF ein anderes MIDI-Instrument oder einen weiteren MOTIF in das 
System einfügen möchten, sollten Sie eine eigene Studio Setup-Datei einrichten. 
Informationen dazu finden Sie im Online-Handbuch zu OMS. 

Je nach Macintosh/Mac OS-Version funktioniert die mitgelieferte OMS-Studio-
Setup-Datei u.U. nicht, obwohl Sie die oben beschriebene Verfahrensweise befolgt 
haben. (Obwohl das Setup ordnungsgemäß beendet wird, können keine MIDI-
Daten gesendet/empfangen werden.) 
Stellen Sie in diesem Fall die Verbindung zwischen Macintosh und MOTIF über das 
USB-Kabel her, und erstellen Sie die Setup-Datei folgendermaßen neu. 

1 Starten Sie das OMS-Setup, und wählen Sie im Menü [File] (Datei) die 
Menüoption [New Setup] (Neues Setup) aus. 

2 Daraufhin wird das Dialogfenster „OMS Driver Search“ (Suche nach OMS-
Treiber) angezeigt. Deaktivieren Sie die Kontrollkästchen „Modem“ und 
„Printer“ (Drucker), und klicken Sie auf [Search] (Suchen), um nach dem Gerät 
zu suchen. 
Wenn der Suchvorgang erfolgreich abgeschlossen wurde, wird im Dialogfenster 
zur Einstellung des OMS-Treibers das Gerät [USB-MIDI] angezeigt.

3 Klicken Sie auf [OK], um nach den Ports zu suchen. Im Dialogfenster wird 
„Port 1“, „Port 2“ ... angezeigt. Aktivieren Sie das gewünschte Kontrollkästchen 
für den Port, und klicken Sie auf [OK], um die Einstellung zu speichern. 

Einzelheiten zur Verwendung von OMS finden Sie in der entsprechenden 
OMS-Dokumentation.

Zeigt an, daß diese Installation zur Verfügung steht

Wenn „MOTIF ES-USB_multi“ geöffnet wird:
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Für Windows-/Macintosh-Benutzer
Informationen zum Fenster „USB Driver Setup“
In diesem Fenster können Sie die zum MOTIF gesendete MIDI-Port-Nummer auf eine andere als in der Sequencer-Software eingestellte Nummer ändern. 
Bei Verwendung eines Windows-Betriebssystems wählen Sie den Befehlspfad � [START] (� [Einstellungen]) � [Systemsteuerung] � [MIDI-USB Driver], um das 
Installationsfenster des Treibers zu öffnen.
Bei einem Mac-Betriebssystem wählen Sie das Festplattensymbol [HD] � [Systemordner] � [YAMAHA USB MIDI Patch], um das Installationsfenster zu öffnen.
Die Standardeinstellungen lauten wie folgt. 

* Das ist die Nummer des MIDI-Ports, die im Display [UTILITY] � [F5] MIDI � [SF4] OTHER eingestellt wurde.

Port-Nummer MIDI OUT-Schnittstelle 
(Thru-Port-Nummer*)

MIDI IN-Schnittstelle 
(Track-Port-Nummer)

1 MIDI OUT (1) MIDI IN (1)

2 MIDI OUT (2) MIDI IN (2)

3 MIDI OUT (3) MIDI IN (3)

4 MIDI OUT (4) MIDI IN (4)

5 MIDI OUT (5) -

6 MIDI OUT (6) -

7 MIDI OUT (7) -

8 MIDI OUT (8) -
10   TOOLS for MOTIF ES6/MOTIF ES7/MOTIF ES8 Installationshandbuch
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Fehlerbehebung
Der Treiber läßt sich nicht installieren.

• Ist das USB-Kabel ordnungsgemäß angeschlossen?
� Überprüfen Sie die USB-Kabelverbindung. 
� Ziehen Sie das USB-Kabel ab, und schließen Sie es erneut an.

Windows
• Wurde die USB-Funktion auf Ihrem Computer aktiviert?

� Wenn Sie den MOTIF zum ersten Mal an den Computer anschließen und 
der Hardware-Assistent nicht erscheint, kann es sein, daß die USB-
Schnittstelle Ihres Computers gar nicht aktiviert ist. Führen Sie die 
folgenden Schritte durch. 

1 Wählen Sie den Befehlspfad [Systemsteuerung] � [System] � [Geräte-
Manager] (unter Windows 98/Me) bzw. den Befehlspfad 
[Systemsteuerung]* � [System] � [Hardware] � [Geräte-Manager] 
(unter Windows 2000/XP).

* Klassische Ansicht nur unter XP.

2 Vergewissern Sie sich, daß neben „Universeller serieller Bus 
Controller“ oder „USB-Stammhub“ bzw. „USB-Root-Hub“ keine der 
Markierungen „!“ oder „x“ angezeigt wird. Wenn dies der Fall ist, ist 
der USB-Controller nicht aktiviert.

• Wurde ein unbekanntes Gerät registriert?
� Falls die Treiberinstallation fehlschlägt, wird der MOTIF als 

„Unbekanntes Gerät“ registriert, und Sie können den Treiber nicht 
installieren. Führen Sie die folgenden Schritte durch, um das „unbekannte 
Gerät“ zu löschen.

1 Wählen Sie den Befehlspfad [Systemsteuerung] � [System] � [Geräte-
Manager] (unter Windows 98/Me) bzw. den Befehlspfad 
[Systemsteuerung]* � [System] � [Hardware] � [Geräte-Manager] 
(unter Windows 2000/XP).

* Klassische Ansicht nur unter Windows XP.

2 Wählen Sie die Option „Modelle nach Typ anzeigen“ aus, und suchen 
Sie nach „Andere Geräte“.

3 Wenn Sie einen Eintrag bei „Andere Geräte“ finden, öffnen Sie dessen 
Baumstruktur, indem Sie darauf doppelklicken, und suchen Sie dort 
nach einem „Unbekannten Gerät“. Falls dort eines aufgeführt wird, 
markieren Sie es, und klicken Sie auf die Schaltfläche [Entfernen].

4 Ziehen Sie das USB-Kabel vom MOTIF ES ab, und stecken Sie es 
wieder ein.

5 Installieren Sie den Treiber neu. 

� Windows98/Me-Benutzer .. siehe Seite 4

� Windows2000-Benutzer ..... siehe Seite 5

� WindowsXP-Benutzer......... siehe Seite 5

Wenn der MOTIF durch den Computer via USB gesteuert wird, 
funktioniert er nicht richtig oder erzeugt keinen Ton.

• Haben Sie den Treiber installiert?
• Ist das USB-Kabel ordnungsgemäß angeschlossen? 
• Sind die Lautstärke-Einstellungen des Klangerzeugers, der Verstärkeranlage 

und der Anwendungssoftware auf geeignete Werte gestellt?
• Haben Sie in der Sequencer-Software einen geeigneten Port ausgewählt?
• Überprüfen Sie, ob die Einstellung für „MIDI IN/OUT“ im Utility-Modus 

der aktuell verwendeten Verbindungsart entspricht (USB oder MIDI).

Die Wiedergabe erfolgt verzögert.

• Erfüllt der Computer die Systemanforderungen? 
• Werden gleichzeitig andere Anwendungen oder Gerätetreiber ausgeführt?

Macintosh
�Schalten Sie den virtuellen Speicher aus.
�Deaktivieren Sie AppleTalk.

Der Standby-Modus des Rechners läßt sich nicht richtig aktivieren 
bzw. beenden.

• Versetzen Sie den Computer nicht in den Standby-Modus, während eine 
MIDI-Anwendung ausgeführt wird.

• Wenn Sie Windows 2000 verwenden, können Sie je nach 
Systemkonfiguration (USB Host Controller usw.) den Computer u.U. nicht 
normal in den Ruhezustand versetzen. Dennoch sollte ein simples Abziehen 
und Wiederanschließen des USB-Kabels dazu führen, daß Sie den MOTIF 
wieder steuern können.

Wie läßt sich der Treiber entfernen oder neu installieren?

Windows Me/98
1 Wenn der MOTIF ES ordnungsgemäß erkannt wird, doppelklicken Sie in 

der Systemsteuerung auf „System“, um das Fenster „Eigenschaften von 
System“ zu öffnen.

2 Doppelklicken Sie auf die Registerkarte „Geräte-Manager“, markieren Sie 
„YAMAHA USB MIDI Driver“, und entfernen Sie diesen.

3 Verwenden Sie die MS-DOS-Eingabeaufforderung oder den Explorer, um 
die folgenden drei Dateien zu entfernen. 

Um diese Dateien mit dem Explorer zu löschen, klicken Sie im Menü [Ansicht] auf 
[Ordneroptionen], und wählen Sie auf der Registerkarte [Ansicht] die Option „Alle 
Dateien anzeigen“ aus.
• \WINDOWS\INF\OTHER\YAMAHAMOTIF6.INF
• \WINDOWS\SYSTEM\Xgusb.drv
• \WINDOWS\SYSTEM\Ymidusb.sys

4 Ziehen Sie das USB-Kabel ab.

5 Starten Sie den Computer neu.

6 Installieren Sie den Treiber neu. 

Macintosh
1 Löschen Sie die Dateien in den folgenden Ordnern:

• Systemordner | Kontrollfelder | YAMAHA USB MIDI Patch
• Systemordner | Systemerweiterungen | USB YAMAHA MIDI Driver
• Systemordner | OMS-Ordner | YAMAHA USB MIDI OMS
   Driver

2 Starten Sie den Computer neu.

3 Installieren Sie den Treiber neu, und richten Sie OMS ein.
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Remarques importantes à propos du CD-ROM
Types de données
Ce CD-ROM contient les logiciels d'application. Reportez-vous aux pages 4 (Windows) ou 8 (Macintosh) pour les instructions relatives à l'installation du logiciel. 

N'essayez jamais de lire le CD-ROM sur un lecteur de CD audio. Vous risquez d'endommager votre ouïe ainsi que le lecteur et ses haut-parleurs. 

Format des supports
Le MOTIF ES6/MOTIF ES7/MOTIF ES8 est compatible avec les types de supports suivants.
• MS-DOS    • CD-ROM au format ISO9660

Le MOTIF ES ne peut pas lire directement le contenu du CD-ROM. Celui-ci ne peut être utilisé qu'avec un ordinateur.

n Lorsqu'un fichier en lecture seule est copié sur la carte SmartMedia installée dans le logement à carte du MOTIF ES ou sur le périphérique de stock age USB connecté au MOTIF ES, il ne peut pas 
être supprimé du MOTIF ES.

Systèmes d'exploitation (OS)
Les applications de ce CD-ROM sont proposées dans des versions compatibles avec les systèmes d'exploitation Windows et Macintosh. La procédure d'installation et 
les applications elles-mêmes diffèrent en fonction du système d'exploitation que vous utilisez. Veuillez vous reporter aux instructions d'installation 
correspondantes. 
Pour Windows, reportez-vous à la page 4.
Pour Macintosh, reportez-vous à la page 7.

Procédure d'installation du CD-ROM
Avant d'ouvrir l'emballage scellé du logiciel, lisez attentivement l'accord de licence du logiciel disponible à la fin de ce manuel.

1 Assurez-vous que votre système est conforme à la configuration minimale requise du logiciel (Voice Editor, éditeurs de cartes plug-in, pilote, etc.).

......................................................................................................................................................................................................Windows : page 4 ; Macintosh : page 7

2 Installez le pilote approprié sur votre ordinateur et effectuez les réglages nécessaires.  .......................................................Windows : page 4 ; Macintosh : page 8

3 Installez le logiciel (Voice Editor, etc.).  ....................................................................................................................................Windows : page 5 ; Macintosh : page 9

4 Démarrez le logiciel.

Pour toute opération ultérieure, reportez-vous au mode d'emploi de chaque logiciel (aide en ligne/manuel PDF).

n  Pour pouvoir visualiser des fichiers PDF, vous devez préalablement installer Acrobat Reader sur votre ordinateur (Windows : page 5 ; Macintosh : Page 10).

Solutions rapides
• Modification des réglages des ports MIDI du pilote USB...page 10
• Echec de l'installation du pilote...........................................page 11
• Réponse de reproduction incorrecte ...................................page 11
• Suppression ou réinstallation du pilote...............................page 11

Pour les utilisateurs de Windows
Contenu du CD-ROM
Le CD-ROM contient toute une série d'applications (avec programmes d'installation) et de données dans les dossiers suivants.

* Malheureusement, Yamaha ne peut garantir la stabilité de ces programmes (marqués d'un *), de même qu'il ne peut proposer d'assistance utilisateur pour ceux-ci.
• Toutes les applications répertoriées ci-dessus sont fournies avec des manuels PDF/en ligne.
• Vous pouvez utiliser les logiciels Voice Editor for MOTIF ES6/7/8 ou Multi Part Editor for MOTIF ES6/7/8 comme des logiciels autonomes ou des applications plug-in dans toute application compatible 

avec l'Open Plug-in Technology (Technologie de plug-in ouvert). Pour plus de détails sur l'utilisation de Voice Editor for MOTIF ES6/7/8 ou Multi Part Editor for MOTIF ES6/7/8 en tant que logiciels 
plug-in, reportez-vous au mode d'emploi de l'application client concernée (séquenceur, etc.).

Nom du dossier Nom de l'application Contenu

Acroread_ Acrobat Reader* Visualiseur de PDF (Portable Document Format). Vous permet de visualiser les manuels PDF des 
différentes applications.

Sq01_ SQ01 V2 Nouvelle version de SQ01 V2 avec fonction Audio Mixer étendue, pour créer et reproduire aisément vos 
propres morceaux sur l'ordinateur. Elle peut être utilisée en tant qu'application hôte du logiciel plug-in.

AudioMixer_ (SQ01 V2) Logiciel plug-in du SQ01 V2, qui permet de mixer des pistes audio. (Ne peut pas être utilisé comme 
application autonome).

Twe_ YAMAHA Wave Editor TWE 2.4.4 Vous permet d'éditer les données audio (onde) sur votre ordinateur. 

Tools_ VEMOTES_ Voice Editor for MOTIF ES6/7/8 Vous permet d'éditer les voix du MOTIF ES sur votre ordinateur.

MEMOTES_ Multi Part Editor for MOTIF ES6/7/8 Vous permet d'éditer les paramètres de mixage (tels que les effets) du MOTIF ES sur votre ordinateur 
lorsque vous utilisez le MOTIF ES en tant que générateur de sons multi-timbre. 

USBdrv_ YAMAHA USB MIDI Driver (pour Win98, Me) Permet à votre ordinateur de communiquer avec le MOTIF ES lorsque les deux appareils sont connectés à 
l'aide d'un câble USB.USBdrv2k_ YAMAHA USB MIDI Driver (pour Win2000, XP)

NIdemo_ Démonstration pour le logiciel synthétiseur* Démonstration pour le logiciel synthétiseur du plug-in VST des instruments natifs. 
Dans le dossier « Nidemo », double-cliquez sur « ***Setup.exe » où le nom de fichier correspond au 
logiciel plug-in à installer et suivez ensuite les instructions qui apparaissent à l'écran.

DemoSong Song data Morceaux de démonstration pour le SQ01 V2 lorsque le MOTIF ES est utilisé comme générateur de sons.
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A propos de l'Open Plug-in Technology
Vous pouvez utiliser les logiciels Voice Editor for MOTIF ES6/7/8 ou Multi Part Editor for MOTIF ES6/7/8 comme des logiciels autonomes ou des applications 
plug-in dans toute application compatible avec l'Open Plug-in Technology.
L'Open Plug-in Technology (OPT) est un nouveau format de logiciel qui permet de contrôler les périphériques MIDI à partir d'un séquenceur de logiciel de 
musique. Vous pouvez, par exemple, démarrer et faire fonctionner différents éléments de votre système musical, tels que les éditeurs de carte plug-in et les éditeurs 
de commande de mixage, directement à partir d'un séquenceur compatible OPT, sans devoir les utiliser séparément. En outre, il n'est plus nécessaire de configurer 
les pilotes MIDI pour chaque application, ce qui simplifie votre système de production de musique et rend les opérations plus simples et plus sûres.

A propos des niveaux OPT
La compatibilité de l'application client avec l'OPT comprend trois niveaux différents, comme indiqué ci-dessous.

Niveau 1 – L'OPT Panels prend en charge l'ouverture et l'affichage des panneaux de commande OPT qui peuvent transmettre des données via les ports 
MIDI externes des clients. En général, ce niveau permet aux panneaux de commande de l'éditeur de matériel de base de fonctionner correctement.

Niveau 2 – L'OPT Processors prend en charge les processeurs MIDI et l'automatisation du panneau en temps réel. En général, ce niveau permet aux effets 
MIDI en temps réel et hors ligne (fonction d'arpèges, de transposition, etc.) de fonctionner correctement et d'automatiser le fonctionnement d'OPT Panels. 

Niveau 3 – L'OPT Views prend en charge l'édition des vues et des processeurs/panneaux MIDI qui exigent un accès direct aux structures de stockage du 
séquenceur client. En général, ce niveau permet de gérer des vues d'édition MIDI avancées (éditeurs de listes, accompagnement automatique, contrôleurs de 
données, etc.).

Implémentation du niveau de l'OPT pour Voice Editor
Ce tableau montre la compatibilité du logiciel Voice Editor for MOTIF ES6/7/8 avec l'OPT.

n Il est possible que certaines opérations ne fonctionnent pas correctement s'il n'y a pas de fonction correspondante dans l'application client (séquenceur, etc.). Le niveau d'implémentation le plus 
haut de l'application client apparaît dans le logo OPT (qui s'affiche en même temps que les informations relatives à la version de l'application).

Implémentation du niveau de l'OPT pour Multi Part Editor
Ce tableau montre la compatibilité du logiciel Multi Part Editor for MOTIF6/7/8 avec l'OPT.

Toutes les opérations de Multi Part Editor for MOTIF ES6/7/8 sont fonctionnelles lorsque le logiciel est exploité comme une application plug-in sur les applications 
hôtes de niveaux 2 (Processors) et 3 (Views). Il est possible que certaines applications hôtes ne prennent pas en charge le contrôle à distance.

n Il est possible que certaines opérations ne fonctionnent pas correctement s'il n'y a pas de fonction correspondante dans l'application client (séquenceur, etc.). Le niveau d'implémentation le plus 
haut de l'application client apparaît dans le logo OPT (qui s'affiche en même temps que les informations relatives à la version de l'application).

Niveaux de l'OPT de l'application client
Opérations de Voice Editor for MOTIF ES6/7/8

Prise en charge des opérations Limites aux opérations

VIEWS (Niveau 3)             Oui Aucune

PROCESSORS (Niveau 2) Oui Aucune

PANELS (Niveau 1)          Oui (avec certaines limitations) Réception des données en bloc

Niveaux de l'OPT de l'application client
Opérations de Multi Part Editor for MOTIF ES6/7/8

Prise en charge des opérations Limites aux opérations

VIEWS (Niveau 3)              Oui Aucune

PROCESSORS (Niveau 2)  Oui Aucune

PANELS (Niveau 1)           Oui Réception des données en bloc
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Configuration minimale requise
La configuration matérielle présentée ci-dessous peut varier légèrement selon le 
système d'exploitation utilisé.

• SQ01 V2
Système d'exploitation : Windows 98/Me/2000/XP Edition familiale/

XP Edition professionnelle
Ordinateur : 500 MHz minimum, processeur Intel Pentium/Celeron

(750 MHz ou supérieur pour Windows XP)
Mémoire disponible : 256 Mo minimum
Disque dur : 300 Mo minimum
Ecran : 1024 x 768 pixels minimum

• Voice Editor for MOTIF ES6/7/8
Système d'exploitation : Windows 98/Me/2000/

XP Edition familiale/XP Edition professionnelle
Ordinateur : 166 MHz minimum ;

Processeur Intel Pentium/Celeron
Mémoire disponible : 32 Mo minimum
Disque dur : 24 Mo minimum
Ecran : 640 x 480, haut en couleurs (16 bits) ou supérieur

• Multi Part Editor for MOTIF ES6/7/8
Système d'exploitation : Windows 98/Me/2000/XP Edition familiale/

XP Edition professionnelle
Ordinateur : 166 MHz minimum ;

Processeur Intel Pentium/Celeron
Mémoire disponible : 32 Mo minimum
Disque dur : 32 Mo minimum
Ecran : 1024 x 768, haut en couleurs (16 bits) ou supérieur

• TWE V2.4.4
Système d'exploitation : Windows 95/98/Me/2000/NT/XP
Ordinateur : 166 MHz minimum ;

Processeur Intel Pentium/Celeron
Mémoire disponible : 24 Mo minimum
Disque dur : Temps d'accès moyen de 30 ms ou moins
Ecran :  800 x 600, 256 couleurs minimum

• USB MIDI Driver 
Système d'exploitation : Windows 98/Me/2000/XP Edition Familiale/

XP Edition professionnelle
Ordinateur : 166 MHz minimum ;

Processeur Intel Pentium/Celeron
Mémoire disponible : 32 Mo minimum

(64 Mo ou plus sont recommandés)
Disque dur : 2 Mo minimum

n La configuration minimale requise décrite ci-dessus est en vigueur à partir du 
23 juin 2003. 
Notez que ce logiciel est régulièrement mis à jour et que la configuration requise peut 
faire l'objet de modifications. Vous pouvez vérifier les dernières informations de version 
de chaque programme et la configuration requise en visitant le site Web suivant. 
http://www.yamaha.co.jp/product/syndtm/index.html

Installation des logiciels

Désinstallation (suppression de l'application installée)
Pour supprimer le logiciel installé : 
Sélectionnez [Démarrer] � [Paramètres] � [Panneau de configuration] � 
[Ajout/Suppression de programmes] � [Installer/Désinstaller], puis 
choisissez l'application à supprimer et cliquez sur [Ajouter/Supprimer...]. 
Suivez les instructions qui apparaissent à l'écran pour désinstaller le 
logiciel.

n Les noms des boutons ou des menus peuvent quelque peu varier selon le système 
d'exploitation de votre ordinateur.

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •  
Acrobat Reader

 
Pour visualiser les manuels électroniques (PDF) fournis avec chaque 
application, vous devez installer Acrobat Reader.

 

n Si une version plus ancienne d'Acrobat Reader est installée sur votre PC, vous devez 
d'abord la désinstaller avant de poursuivre.

1 Double-cliquez sur le dossier « Acroread_ ». 
Quatre dossiers correspondant aux différentes langues disponibles 
s'affichent.

2 Sélectionnez la langue que vous souhaitez utiliser et double-cliquez sur le 
dossier correspondant. 
Le fichier « ar***.exe » s'affiche. (« *** » indique la langue sélectionnée).

3 Double-cliquez sur « ar***.exe ».
La boîte de dialogue d'installation d'Acrobat Reader s'ouvre.

4 Effectuez l'installation en suivant les instructions qui apparaissent à l'écran.

Une fois l'installation terminée, le dossier Acrobat apparaît sur votre PC (par 
défaut, dans Programmes).
Pour plus d'informations sur l'utilisation d'Acrobat Reader, reportez-vous au 
Reader Guide (Guide d'Acrobat Reader) dans le menu Help (Aide).

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •
USB MIDI Driver
Pour utiliser le MOTIF ES depuis votre ordinateur via USB, vous devez installer 
le logiciel du pilote approprié.
Le pilote USB MIDI Driver est un logiciel qui transfère des données MIDI entre 
le logiciel de séquençage et le MOTIF ES au moyen d'un câble USB.

Pour Windows 98/Me : voir ci-dessous.
Pour Windows 2000 : voir page 5.
Pour Windows XP : voir page 5.

� Installation du pilote sur Windows 98/Me

1 Allumez l'ordinateur.

2 Insérez le CD-ROM fourni dans le lecteur de CD-ROM.

3 Vérifiez que l'interrupteur POWER du MOTIF ES est réglé sur OFF et 
raccordez la borne USB de l'ordinateur (ou le concentrateur USB) au 
connecteur USB TO HOST du MOTIF ES à l'aide d'un câble USB. Lorsque 
le MOTIF ES est sous tension, l'ordinateur affiche automatiquement la 
fenêtre « Assistant Ajout de nouveau matériel ». Si elle n'apparaît pas, 
cliquez sur « Ajout de nouveau matériel » dans Panneau de configuration.

n Les utilisateurs de Windows Me doivent cocher la case d'option à gauche de « 
Rechercher automat. un meilleur pilote (Recommandé) » et cliquer sur [Suivant]. Le 
système lance automatiquement la recherche et installe le pilote. Passez à l'étape 8. 
Si le système ne détecte pas le pilote, sélectionnez « Spécifier l'emplacement du 
pilote (Avancé) » et spécifiez le dossier « USBdrv_ » du lecteur de CD-ROM pour y 
installer le pilote. 

4 Cliquez sur [Suivant].
La fenêtre vous permet de sélectionner la méthode de recherche souhaitée.

5 Cochez la case d'option à gauche de « Rechercher le meilleur pilote pour 
votre périphérique. (Recommandé) ». Cliquez sur [Suivant]. La fenêtre vous 
permet de sélectionner un emplacement dans lequel installer le pilote.

6 Si vous utilisez Windows 98, cochez la case « Spécifier un emplacement », 
cliquez sur [Parcourir] et spécifiez ensuite le répertoire USBdrv du lecteur 
de CD-ROM (par exemple, D:\USBdrv_\) et poursuivez l'installation. 

Si vous utilisez Windows Me, cochez la case « Lecteur de CD-ROM » et 
décochez tous les autres éléments. Cliquez sur [Suivant].

n Sous Windows Me, le système peut vous demander d'insérer un CD-ROM Windows 
lorsqu'il recherche le pilote. Spécifiez le répertoire USBdrv du lecteur de CD-ROM 
(par exemple, D:\USBdrv_\) et poursuivez l'installation.

7 Quand le système détecte le pilote sur le CD-ROM et qu'il est prêt à 
effectuer l'installation, il affiche le message suivant à l'écran.
Vérifiez la présence du « YAMAHA USB MIDI Driver » dans la liste et 
cliquez sur [Suivant]. Le système lance l'installation.

8 Lorsque l'opération est exécutée, un message s'affiche indiquant que 
l'installation est terminée.
Cliquez sur [Terminer].

n Sur certains ordinateurs, cet écran peut s'afficher au bout d'une dizaine de secondes 
après la fin de l'installation.

Le pilote est maintenant installé.

Ordinateur

MOTIF ES

Câble USB

Pilote

Logiciel de
séquençage
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� Installation du pilote sur Windows 2000

1 Démarrez l'ordinateur et utilisez le compte « Administrateur » pour ouvrir 
la session Windows 2000.

2 Sélectionnez [Poste de travail | Panneau de configuration | Système | 
Matériel | Signature du pilote | Vérification des signatures de fichiers] et 
cochez la case d'option à gauche de « Ignorer : installe tous les fichiers, 
quelles que soient leurs signatures) et cliquez sur [OK].

3 Insérez le CD-ROM fourni dans le lecteur de CD-ROM.

4 Vérifiez que l'interrupteur POWER du MOTIF ES est réglé sur OFF et 
raccordez le connecteur USB de l'ordinateur (ou le concentrateur USB) au 
connecteur USB TO HOST du MOTIF ES à l'aide d'un câble USB. Une fois 
que le MOTIF ES est sous tension, l'ordinateur affiche automatiquement la 
fenêtre « Assistant Ajout de nouveau matériel détecté ». Cliquez sur [Suivant].

5 Cochez la case d'option à gauche de « Rechercher un pilote approprié pour 
mon périphérique. (Recommandé) ». Cliquez sur [Suivant].
La fenêtre qui apparaît alors vous permet de sélectionner un emplacement 
pour installer le pilote.

6 Cochez la case « Lecteurs de CD-ROM » et décochez tous les autres éléments. 
Cliquez sur [Suivant].

n Le système peut vous demander d'insérer un CD-ROM Windows pendant la 
recherche du pilote. Sélectionnez le répertoire « USBdrv2k_ » du lecteur de 
CD-ROM (par exemple, D:\USBdrv2k_\) et poursuivez l'installation.

7 Lorsque l'installation est terminée, l'ordinateur affiche le message « Fin de 
l'Assistant Ajout de nouveau matériel détecté ». Cliquez sur [Terminer].

n Sur certains ordinateurs, cet écran peut s'afficher au bout d'une dizaine de secondes 
après la fin de l'installation. 

8 Redémarrez l'ordinateur. 
Le pilote est maintenant installé.

� Installation du pilote sur Windows XP

1 Allumez l'ordinateur.

2 Sélectionnez [Démarrer] � [Panneau de configuration].
Si le panneau de configuration affiche « Sélectionner une catégorie », cliquez 
sur « Basculer vers l'affichage classique » dans le coin supérieur gauche de la 
fenêtre.
De cette façon, tous les panneaux de configuration et les icônes s'affichent.

3 Sélectionnez [Système] � [Matériel] � [Signature du pilote] � [Vérification 
des signatures de fichiers], cochez la case d'option à gauche de « Ignorer : 
installe tous les fichiers, quelles que soient leurs signatures » et cliquez sur 
[OK].

4 Cliquez sur le bouton [OK] pour fermer la boîte de dialogue Propriétés du 
système, puis sur « X », dans le coin supérieur droit de la fenêtre, pour 
fermer le panneau de configuration.

5 Insérez le CD-ROM fourni dans le lecteur de CD-ROM.

6 Vérifiez d'abord que l'interrupteur POWER du MOTIF ES est réglé sur OFF 
puis raccordez le connecteur USB de l'ordinateur (ou le concentrateur USB) 
au connecteur USB TO HOST du MOTIF ES à l'aide d'un câble USB. Une 
fois que le MOTIF ES est sous tension, l'ordinateur affiche 
automatiquement la fenêtre « Assistant Ajout de nouveau matériel détecté ».

n Sur certains ordinateurs, l'affichage de cet écran peut prendre quelques minutes.

7 Cochez la case d'option à gauche de « Rechercher un pilote approprié pour 
mon périphérique. (Recommandé) ». Cliquez sur [Suivant].
L'installation débute.

8 Lorsque l'installation est terminée, l'ordinateur affiche le message « Fin de 
l'assistant Ajout de nouveau matériel détecté ». Cliquez sur [Terminer].

n Sur certains ordinateurs, cet écran s'affiche au bout de plusieurs minutes après la 
fin de l'installation.

9 Redémarrez l'ordinateur.
Le pilote est maintenant installé.

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •
SQ01 V2
Au cours de la procédure d'installation du logiciel SQ01 V2, vous pouvez 
également installer Voice Editor for MOTIF ES 6/7/8, Multi Part Editor for 
MOTIF ES 6/7/8 et Wave Editor TWE comme logiciels plug-in du SQ01 V2. 

1 Double-cliquez sur le dossier « SQ01_ ». 
Différents fichiers, parmi lesquels « setup.exe », s'affichent.

2 Double-cliquez sur « Setup.exe ».
La boîte de dialogue d'installation de SQ01 s'affiche.

3 Procédez à l'installation en suivant les indications qui apparaissent à l'écran.
Après l'installation, sélectionnez « Restart » (Redémarrer). Après le 
redémarrage de Windows, vous trouverez le dossier YAMAHA sur votre PC 
(par défaut, dans Programmes) et le dossier SQ01 dans le dossier YAMAHA.
Reportez-vous aux manuels d'aide en ligne pour apprendre à utiliser 
l'application.

Configuration MIDI du SQ01 V2
1 Lancez le SQ01 V2.

Dans le menu [Démarrer], sélectionnez [Programmes], puis 
[YAMAHA SQ01 Ver.2.0] � [SQ01].

2 Dans le menu [Setup] (Configuration) de la fenêtre Track View 
(Piste), sélectionnez [MIDI] � [Device] (Périphérique) pour afficher 
la page « Device » de la boîte de dialogue « MIDI ».

3 Sélectionnez le port de sortie approprié (par exemple, « YAMAHA 
USB OUT 0-1 ») dans la fenêtre [OUT] (Sortie) pour utiliser la 
connexion USB avec le MOTIF ES.

4 Sélectionnez le port d'entrée approprié (par exemple, « YAMAHA 
USB IN 0-1 ») dans la fenêtre [IN] (Entrée), puis cliquez sur [OK] 
pour refermer la boîte de dialogue.

nSi nécessaire, vous pouvez sélectionner le pilote audio ainsi que le périphérique 
d'entrée/sortie audio. Dans le menu [Setup], sélectionnez [Audio] � [Device] 
pour afficher la page « Device » de la boîte de dialogue « Audio ».

nLa connexion USB vers le MOTIF ES ne peut être utilisée que pour transférer des 
données MIDI. Elle ne permet pas de transférer des données audio. 

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •
Voice Editor et Multi Part Editor
Une fois que vous avez installé les logiciels, vous pouvez utiliser votre 
ordinateur pour éditer les réglages de voix et de mixage du MOTIF ES.

1 Double-cliquez sur le dossier « Tools » (Outils) du CD-ROM. 
Les dossiers « VEMOTES_ » et « MEMOTES_ » s'affichent. 

2 Double-cliquez sur le dossier « VEMOTES_ » ou « MEMOTES_ ». 
Le fichier « setup.exe » s'affiche. 

3 Double-cliquez sur le fichier « setup.exe ». 
La boîte de dialogue de configuration de Voice Editor ou Multi Part Editor 
Tools s'affiche. 

4 Effectuez l'installation en suivant les instructions qui apparaissent à l'écran. 

Pour plus de détails, reportez-vous à l'aide en ligne ou au mode d'emploi PDF 
du logiciel concerné. 

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •
TWE (utilisation comme logiciel autonome)
Au cours de la procédure d'installation du SQ01 V2, vous pouvez également 
installer TWE, qui vous permet d'éditer les données d'onde directement sur 
votre ordinateur, en tant que logiciel plug-in de SQ01 V2. Si vous souhaitez 
installer uniquement TWE, suivez les instructions ci-dessous.

1 Double-cliquez sur le dossier « Twe_ ». 

2 Sélectionnez la langue que vous voulez utiliser et double-cliquez sur 
« setup.exe ». 

3 Effectuez l'installation en suivant les instructions qui apparaissent à l'écran. 
Pour plus de détails sur cette opération, reportez-vous au manuel PDF 
disponible dans ce dossier. 
TOOLS for MOTIF ES6/MOTIF ES7/MOTIF ES8 Manuel d’installation   5



Fra
n
ça

is
Configuration du port MIDI
(lors du démarrage du logiciel en tant 
qu'application autonome)
Avant de configurer le port MIDI dans Voice Editor ou Multi Port Editor, vous 
devez définir le port MIDI depuis la barre d'outils MIDI SETUP (Configuration 
MIDI). 

n Pour lancer Voice Editor ou Multi Part Editor en tant qu'application plug-in dans une 
application compatible avec l'Open Plug-in Technology, reportez-vous aux manuels PDF 
des logiciels concernés.

1 Démarrez Voice Editor ou Multi Part Editor. 

2 Cliquez sur le bouton MIDI Setup de la barre d'outils appelée à l'étape 1. 

3 Dans la fenêtre MIDI Setup appelée à l'étape 2, cliquez sur le bouton [�] à 
l'extrême droite de chaque case et effectuez les réglages de port comme 
indiqué.

n Pour que des ports MIDI soient disponibles ici, vous devez sélectionner le port MIDI 
approprié dans chaque logiciel d'application (Voice Editor ou Multi Port Editor). 
C'est le port que vous utiliserez dans les différents logiciels. Pour plus de détails sur 
la configuration du port MIDI, reportez-vous au manuel en ligne de chaque logiciel. 

Bouton MIDI Setup
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Pour les utilisateurs de Macintosh
Contenu du CD-ROM
Le CD-ROM comprend deux dossiers : « International » et « Japanese ». Double-cliquez sur le dossier « International » pour l'ouvrir. Ces dossiers contiennent 
diverses applications (avec programmes d'installation) et données.

* Malheureusement, Yamaha ne peut garantir la stabilité de ces programmes (marqués d'un *), de même qu'il ne peut proposer d'assistance utilisateur 
pour ceux-ci.

• Toutes les applications répertoriées ci-dessus sont fournies avec des manuels PDF/en ligne.

Configuration minimale requise
La configuration matérielle présentée ci-dessous peut quelque peu varier selon le système d'exploitation utilisé.

• Voice Editor for MOTIF ES6/7/8
Système d'exploitation : Mac OS 8.6 à OS 9.22 (les environnements Mac OS X et Mac Classic ne sont pas pris en charge)
Ordinateur : Ordinateur Macintosh avec unité centrale PowerPC ou ultérieure
Mémoire disponible : 18 Mo minimum
Disque dur : 64 Mo minimum
Ecran :  800 x 600, 32 000 couleurs ou plus

• TWE V2.3
Système d'exploitation : Mac OS 7.6.1 à OS 9.22 (les environnements Mac OS X et Mac Classic ne sont pas pris en charge)
Ordinateur : Ordinateur Macintosh avec unité centrale PowerPC ou ultérieure
Mémoire disponible : 8 Mo minimum
Disque dur : Temps d'accès moyen de 30 ms ou moins
Ecran : 640 x 400, 256 couleurs ou plus

• USB MIDI Driver 
Système d'exploitation : Mac OS 8.6 à OS 9.22 (les environnements Mac OS X et Mac Classic ne sont pas pris en charge)
Ordinateur : Ordinateur Macintosh avec borne USB et unité centrale PowerPC ou ultérieure
Mémoire : 64 Mo minimum (128 Mo ou plus sont recommandés)
n Désactivez la mémoire virtuelle.

Disque dur : 2 Mo minimum
Autre : OMS 2.3.8 (disponible sur le CD-ROM fourni dans l'emballage)

n La configuration minimale requise décrite ci-dessus est en vigueur à partir du 23 juin 2003. 
Notez que ce logiciel est régulièrement mis à jour et que la configuration requise peut faire l'objet de modifications.
Vous pouvez vérifier les dernières informations de version de chaque programme et la configuration requise en visitant le site Web suivant. 
http://www.yamaha.co.jp/product/syndtm/index.html

Nom du dossier Nom de l'application Contenu
Acroread_ Acrobat Reader* Visualiseur de PDF (Portable Document Format). Vous permet de visualiser les manuels PDF 

des différentes applications.

OMS_ OMS Open Music System (OMS)* Vous permet d'utiliser simultanément plusieurs applications MIDI sous le système 
d'exploitation Mac.

OMS Setup OMS Setup for YAMAHA Contient les fichiers de configuration OMS pour les générateurs de sons Yamaha.

USBdrv_ YAMAHA USB MIDI Driver Permet à votre ordinateur de communiquer avec le MOTIF ES lorsque les deux appareils sont 
connectés à l'aide d'un câble USB.

VEMOTES_ Voice Editor for MOTIF ES6/7/8 Vous permet d'éditer les voix du MOTIF ES sur votre ordinateur.

Twe_ YAMAHA Wave Editor TWE 2.3 Vous permet d'éditer les données audio (onde) sur votre ordinateur. 

NIdemo_ Démonstration pour le logiciel synthétiseur* Démonstration pour le logiciel synthétiseur du plug-in VST des instruments natifs.
Dans le dossier « Nidemo », double-cliquez sur « ***Demo Install/installer » où le nom de 
fichier correspond au logiciel plug-in à installer et suivez ensuite les instructions qui 
apparaissent à l'écran. 
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Installation des logiciels

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •  
Acrobat Reader

 
Pour pouvoir visualiser les manuels électroniques (PDF) fournis avec chaque 
application, vous devez installer Acrobat Reader. 

1 Double-cliquez sur le dossier « Acroread_ ».
Trois dossiers correspondant aux différentes langues disponibles 
s'affichent : English, German et French.

2 Sélectionnez la langue que vous souhaitez utiliser et double-cliquez sur le 
dossier correspondant.
« Reader Installer » s'affiche.
Le nom du programme d'installation peut varier en fonction de la langue 
sélectionnée.

3 Double-cliquez sur « Reader Installer ».
La boîte de dialogue d'installation d'Acrobat Reader s'affiche.

4 Procédez à l'installation en suivant les indications qui apparaissent à l'écran.
Une fois l'installation terminée, le dossier Acrobat apparaît sur votre 
ordinateur (par défaut, sur le disque dur).
Pour plus d'informations sur l'utilisation d'Acrobat Reader, reportez-vous 
au Reader Guide du menu Help.

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •  
Open Music System (OMS) 2.3.8

 
OMS vous permet d'utiliser simultanément plusieurs applications MIDI sur le 
système d'exploitation Mac.

1 Double-cliquez sur le dossier « OMS » (uniquement disponible en anglais).
« Install OMS 2.3.8 » s'affiche.

2 Double-cliquez sur « Install OMS 2.3.8 ».
La boîte de dialogue OMS Setup (Installation d'OMS) s'affiche.

3 Effectuez l'installation en suivant les instructions qui apparaissent à l'écran. 
Après l'installation, sélectionnez « Restart » (Redémarrer).

n Au terme de l'installation, il est possible qu'un message d'erreur s'affiche indiquant 
que le programme d'installation ne s'est pas fermé. Dans ce cas, allez dans le menu 
« File » (Fichier) et sélectionnez « Quit » (Quitter) pour fermer le programme 
d'installation. Redémarrez ensuite l'ordinateur.

Après avoir redémarré votre Macintosh, vous trouverez les dossiers 
« Opcode » et « OMS Applications » sur votre ordinateur (par défaut, sur le 
disque dur).

4 Copiez le fichier « OMS_2.3_Mac.pdf » depuis le CD-ROM vers le dossier 
« OMS Applications » en effectuant une opération de glisser-déposer.
Reportez-vous au fichier « OMS_2.3_Mac.pdf » (version anglaise 
uniquement) pour plus d'informations sur l'utilisation de l'application.

5 Copiez le dossier « OMS Setup for YAMAHA » depuis le CD-ROM vers le 
dossier « OMS Applications », en effectuant une opération de glisser-déposer.
Le dossier « OMS Setup for YAMAHA » contient les fichiers d'installation 
OMS pour les générateurs de sons Yamaha, qui peuvent être utilisés comme 
modèles.

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •  
USB MIDI Driver

 
Pour utiliser le MOTIF ES depuis votre ordinateur via USB, vous devez installer 
le logiciel du pilote approprié.
Le pilote USB MIDI Driver est un logiciel qui transfère des données MIDI entre 
le logiciel de séquençage et le MOTIF ES au moyen d'un câble USB.

Installez d'abord OMS avant d'installer le pilote MIDI USB. En outre, après 
avoir installé le pilote, vous devez configurer OMS (ci-dessus).

1 Allumez l'ordinateur.

2 Insérez le CD-ROM fourni dans le lecteur de CD-ROM. Le système affiche 
l'icône du CD-ROM sur le bureau.

3 Double-cliquez sur l'icône du CD-ROM, puis sur l'icône « Install USB 
Driver » (Installer le pilote USB) dans le dossier « USBdrv_ » pour afficher 
l'écran d'installation suivant. 

4 La zone « Install Location » (Emplacement d'installation) affiche la 
destination de l'installation. Si vous souhaitez changer le disque ou le 
dossier de destination, utilisez le bouton [Switch Disk] (Changer de disque) 
et le menu déroulant pour définir la destination souhaitée.

n Cette zone affiche généralement le disque de démarrage en tant que destination.

5 Cliquez sur le bouton [Install]. Le système affiche un message vous invitant 
à redémarrer l'ordinateur. Cliquez sur [Continue] (Poursuivre) pour fermer 
toutes les applications et redémarrer l'ordinateur.

n Pour annuler l'installation, cliquez sur [Cancel] (Annuler).

6 L'installation débute. Si le pilote a déjà été installé, le message suivant 
apparaîtra. Pour retourner à l'étape 3, appuyez sur [Continue]. Pour 
interrompre l'installation, cliquez sur [Quit] (Fermer).

7 Lorsque l'installation est terminée, le système affiche un message vous 
invitant à redémarrer l'ordinateur. Cliquez sur [Restart]. L'ordinateur 
redémarre automatiquement. Vous pouvez trouver les fichiers installés aux 
endroits suivants :

• System Folder | Control Panels | YAMAHA USB MIDI Patch
• System Folder | Extensions | USB YAMAHA MIDI Driver
• System Folder | OMS Folder | YAMAHA USB MIDI OMS Driver

Ordinateur

Logiciel de
séquençage

OMS Pilote

Câble USB

MOTIF ES
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• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •  
Voice Editor

 
Une fois que vous avez installé les logiciels, vous pouvez utiliser votre 
ordinateur pour éditer les voix du MOTIF ES. 

1 Double-cliquez sur le dossier « International » du CD-ROM. 
Le dossier « VEMOTES_ » s'affiche. 

2 Double-cliquez sur le dossier « VEMOTES_ ». 
Le fichier « Install VoiceEditorFor MOTIF ES » (Installer Voice Editor pour 
le MOTIF ES) s'affiche. 

3 Double-cliquez sur le fichier « Install VoiceEditorFor MOTIF ES ». 
La boîte de dialogue pour l'installation de Voice Editor s'ouvre. Procédez à 
l'installation en suivant les instructions qui apparaissent à l'écran. 

4 Après l'installation, redémarrez l'ordinateur. 

Pour plus de détails, reportez-vous à l'aide en ligne ou au PDF du mode 
d'emploi. 

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •  
TWE

 
Le logiciel d'édition audio TWE vous permet d'éditer des données d'onde 
directement sur votre ordinateur.

1 Double-cliquez sur le dossier « TWE ». 
Quatre dossiers correspondant aux différentes langues disponibles 
s'affichent. 

2 Sélectionnez la langue que vous souhaitez utiliser et double-cliquez sur son 
dossier. 
Le dossier « YAMAHA TWE » s'affiche. 

3 Copiez le dossier « YAMAHA TWE » sur le disque dur de votre ordinateur. 
Pour plus de détails sur l'utilisation de TWE, reportez-vous au manuel en 
ligne contenu dans le dossier.

Configuration de l'OMS
Le fichier de configuration du studio OMS pour le MOTIF ES se trouve sur le 
CD-ROM inclus. Il est utilisé pour configurer l'OMS. 

n Avant d'exécuter la procédure suivante, vous devez installer le système OMS et le 
logiciel USB MIDI Driver. 

1 Utilisez un câble USB pour connecter la borne USB de l'ordinateur (ou le 
concentrateur USB) à la borne USB du MOTIF ES, puis mettez ce dernier 
sous tension. 

2 Allumez l'ordinateur. 

3 Insérez le CD-ROM inclus dans le lecteur de CD-ROM de votre Macintosh. 
L'icône du CD-ROM apparaît sur le bureau. 

4 Double-cliquez sur l'icône du CD-ROM, « International », « OMS » et « OMS 
Setup for YAMAHA ». 
Les deux fichiers « MOTIF ES-USB » et « MOTIF ES-USB_multi » 
apparaissent. Copiez-les sur le disque dur de votre ordinateur. 

5 Double-cliquez sur le fichier « MOTIF ES-USB » ou « MOTIF-USB_multi » 
pour lancer la configuration d'OMS. Les fichiers de configuration du studio 
se présentent comme suit. 

• MOTIF ES-USB
Ce fichier est utilisé lorsque vous connectez un seul MOTIF ES à 
l'ordinateur, à l'aide d'un port unique (jusqu'à 16 canaux MIDI). 

• MOTIF ES-USB_multi
Ce fichier est utilisé lorsque vous connectez plusieurs MOTIF ES à 
l'ordinateur en utilisant un total de huit ports (jusqu'à 128 canaux 
MIDI). Veuillez noter qu'un seul MOTIF ES peut gérer trois ports au 
maximum (jusqu'à 48 canaux MIDI). 

n L'utilisation d'un concentrateur USB est nécessaire lorsque plusieurs MOTIF ES 
sont connectés à l'ordinateur. 

n Assurez-vous de sélectionner [MOTIF ES-USB_multi] lorsque vous utilisez la 
fonction Remote Control du MOTIF ES via le câble USB, dans la mesure où le port 3 
est utilisé dans ce cas. 

6 Après avoir lancé OMS Setup, le fichier de configuration du studio sur 
lequel vous avez double-cliqué à l'étape 5 s'ouvre. 

n Si le symbole «  » n'apparaît pas à la droite du nom du fichier de configuration, 
sélectionnez « Make Current » (Activer) dans le menu « File » et exécutez l'opération 
de sauvegarde. 

La configuration du studio OMS est terminée.

n Une fois la configuration du studio OMS ci-dessus terminée, votre ordinateur ne 
reconnaît plus que le MOTIF comme instrument MIDI. Si vous utilisez un autre 
instrument MIDI en plus du MOTIF ou que vous ajoutez un deuxième MOTIF au 
système existant, vous devez créer un fichier de configuration du studio original. 
Pour plus de détails, reportez-vous au manuel en ligne fourni avec l'OMS. 

n Il est possible que le fichier de configuration du studio OMS ne fonctionne pas 
même si vous avez suivi la procédure ci-dessus, selon la version de votre Macintosh/
Mac OS. (Il est impossible de transmettre ou recevoir des données MIDI même 
lorsque la configuration est disponible). 
Dans ce cas, connectez votre Macintosh au MOTIF via le câble USB et suivez la 
procédure suivante pour recréer le fichier de configuration. 

1 Lancez OMS Setup et sélectionnez « New Setup » (Nouvelle configuration) dans le 
menu « File ». 

2 La boîte de dialogue « OMS Driver Search » (Recherche du pilote OMS) apparaît. 
Décochez les cases « Modem » et « Printer » (Imprimante), puis cliquez sur 
[Search] (Rechercher) pour lancer la recherche de périphérique. 
Si l'opération de recherche se déroule correctement, le périphérique [USB-MIDI] 
apparaît dans la boîte de dialogue de configuration du pilote OMS.

3 Cliquez sur le bouton [OK] pour rechercher des ports. Port 1, Port 2, ... 
apparaissent dans la boîte de dialogue. Cochez la case du port approprié et 
cliquez sur le bouton [OK] pour stocker la configuration. 

Pour plus de détails sur l'utilisation de l'OMS, reportez-vous à la 
documentation OMS correspondante.

Indique que cette configuration est disponible

Lorsque vous ouvrez « MOTIF ES-USB_multi » :
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Pour les utilisateurs de Windows/Macintosh
A propos de la fenêtre USB Driver Setup
Cette fenêtre vous permet de modifier le numéro de port MIDI envoyé au MOTIF à partir du numéro de port réglé dans le logiciel de séquençage de l'ordinateur. 
Dans Windows, sélectionnez [Démarrer] (�(Paramètres)) � [Panneau de configuration] � [MIDI USB Driver] pour ouvrir la fenêtre de configuration du pilote.
Sous Macintosh, sélectionnez le menu [Apple] � [Control Panels] � [YAMAHA USB MIDI Patch] pour ouvrir la fenêtre de configuration.
Les réglages par défaut sont les suivants. 

* Il s'agit en fait du numéro de port MIDI paramétré dans l'écran [UTILITY] � [F5] MIDI � [SF4] OTHER.

Numéro de 
port

Borne MIDI OUT 
(numéro du port relais*)

Borne MIDI IN (numéro 
du port de piste)

1 MIDI OUT (1) MIDI IN (1)

2 MIDI OUT (2) MIDI IN (2)

3 MIDI OUT (3) MIDI IN (3)

4 MIDI OUT (4) MIDI IN (4)

5 MIDI OUT (5) -

6 MIDI OUT (6) -

7 MIDI OUT (7) -

8 MIDI OUT (8) -
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Dépistages des pannes
Il est impossible d'installer le pilote.

• Le câble USB est-il correctement connecté ?
� Vérifiez la connexion du câble USB. 
� Déconnectez le câble USB, puis rebranchez-le.

Windows
• La fonction USB est-elle activée sur votre ordinateur ?

� Lorsque vous connectez le MOTIF à l'ordinateur pour la première fois, si 
l'assistant « Assistant Ajout de nouveau matériel » n'apparaît pas, cela 
peut vouloir dire que la fonction USB de l'ordinateur est désactivée. 
Procédez comme suit. 

1 Sélectionnez [Panneau de configuration] � [Système] � [Gestionnaire 
de périphériques] (pour Windows 98/Me) ou [Panneau de 
configuration]* � [Système] � [Matériel] � [Gestionnaire de 
périphériques] (pour Windows 2000/XP).

* Affichage classique uniquement sous Windows XP.

2 Assurez-vous qu'aucun symbole « ! » ou « x » n'apparaît à côté de 
« Contrôleur de bus USB » ou « Concentrateur USB racine ». Si l'un de 
ces symboles apparaît, cela signifie que le contrôleur USB est désactivé.

• Des périphériques inconnus sont-ils enregistrés ?
� Si l'installation du pilote échoue, le MOTIF sera considéré comme un 

« Périphérique inconnu » et vous ne parviendrez pas à installer le pilote. 
Supprimer le « Périphérique inconnu » en suivant les étapes suivantes.

1 Sélectionnez [Panneau de configuration] � [Système] � [Gestionnaire 
de périphériques] (pour Windows 98/Me) ou [Panneau de 
configuration]* � [Système] � [Matériel] � [Gestionnaire de 
périphériques] (pour Windows 2000/XP).

* Affichage classique uniquement sous Windows XP.

2 Recherchez « Autres périphériques » dans le menu « Affichage » sous 
« Périphériques par type ».

3 Si vous trouvez l'élément « Autres périphériques », double-cliquez 
dessus pour développer l'arborescence et rechercher « Périphérique 
inconnu ». S'il en existe un, sélectionnez-le et cliquez sur le bouton 
[Supprimer].

4 Retirez le câble USB du MOTIF et rebranchez-le.

5 Réinstallez le pilote. 

� Utilisateurs de Windows 98/Me .......voir page 4

� Utilisateurs de Windows 2000 ..........voir page 5

� Utilisateurs de Windows XP..............voir page 5

Lorsque vous contrôlez le MOTIF depuis votre ordinateur via l'USB, 
l'instrument ne fonctionne pas correctement ou aucun son n'est 
audible.

• Avez-vous installé le pilote ?
• Le câble USB est-il correctement connecté ? 
• Les réglages de volume du générateur de sons, du périphérique de 

reproduction et du programme d'application sont-ils spécifiés sur des niveaux 
appropriés ?

• Avez-vous sélectionné un port adéquat dans le logiciel de séquençage ?
• Vérifiez si le réglage MIDI IN/OUT en mode Utility correspond au câble 

réellement utilisé (USB ou MIDI).

La réponse de reproduction est lente.

• Votre ordinateur respecte-t-il la configuration minimale ? 
• Un autre pilote de périphérique ou d'application est-il en cours d'utilisation ?

Macintosh
�Désactivez la mémoire virtuelle.
�Désactivez AppleTalk.

Impossible d'arrêter ou de relancer correctement l'ordinateur.

• N'arrêtez pas l'ordinateur tant que l'application MIDI fonctionne.
• Si vous utilisez Windows 2000, vous pouvez ne pas être en mesure d'arrêter 

ou de redémarrer normalement, en fonction de l'environnement (contrôleur 
d'hôte USB, etc.). Même dans ce cas, le simple fait de déconnecter et de 
rebrancher le câble USB vous permettra d'utiliser à nouveau les fonctions du 
MOTIF.

Comment supprimer ou réinstaller le pilote ?

Windows Me/98
1 Lorsque le MOTIF ES est correctement reconnu, double-cliquez sur 

« Système » dans Panneau de configuration pour ouvrir la fenêtre Propriétés 
système.

2 Double-cliquez sur l'onglet « Gestionnaire de périphériques », sélectionnez 
« YAMAHA USB MIDI Driver » et supprimez-le.

3 Utilisez l'invite MS-DOS ou l'explorateur pour supprimer les trois fichiers 
suivants. 

n Pour supprimer ces fichiers à l'aide de l'explorateur, sélectionnez « Options des 
dossiers » dans le menu Outil (Affichage) et sélectionnez « Afficher tous les fichiers 
(et dossiers) ».
• \WINDOWS\INF\OTHER\YAMAHAMOTIF6.INF
• \WINDOWS\SYSTEM\Xgusb.drv
• \WINDOWS\SYSTEM\Ymidusb.sys

4 Débranchez le câble USB.

5 Redémarrez l'ordinateur.

6 Réinstallez le pilote. 

Macintosh
1 Supprimez les fichiers des emplacements suivants :

• System Folder | Control Panels | YAMAHA USB MIDI Patch
• System Folder | Extensions | USB YAMAHA MIDI Driver
• System Folder | OMS Folder | YAMAHA USB MIDI OMS 
   Driver

2 Redémarrez l'ordinateur.

3 Installez le pilote et configurez l'OMS.
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SOFTWARE LICENSING AGREEMENT
The following is a legal agreement between you, the end user, and Yamaha Corporation (“Yamaha”). The enclosed Yamaha software 
program is licensed by Yamaha to the original purchaser for use only on the terms set forth herein. Please read this licensing agreement 
with care. Opening this package indicates that you accept all terms outlined herein. If you do not agree to the terms, return this package 
unopened to Yamaha for a full refund.

1. GRANT OF LICENSE AND COPYRIGHT
Yamaha grants you, the original purchaser, the right to use one copy of the enclosed software program and data (“SOFTWARE”) on a 
single-user computer system. You may not use it on more than one computer or computer terminal. The SOFTWARE is owned by 
Yamaha and is protected by Japanese copyright laws and all applicable international treaty provisions. You are entitled to claim 
ownership of the media in which the SOFTWARE is included. Therefore, you must treat the SOFTWARE like any other copyrighted 
materials.

2. RESTRICTIONS
The SOFTWARE program is copyrighted. You may not engage in reverse engineering or reproduction of the SOFTWARE by other 
conceivable methods. You may not reproduce, modify, change, rent, lease, resell, or distribute the SOFTWARE in whole or in part, or 
create derivative works from the SOFTWARE. You may not transmit or network the SOFTWARE with other computers. You may 
transfer ownership of the SOFTWARE and the accompanying written materials on a permanent basis provided that you retain no copies 
and the recipient agrees to the terms of the licensing agreement.

3. TERMINATION
The licensing condition of the software program becomes effective on the day that you receive the SOFTWARE. If any one of the 
copyright laws or clauses of the licensing conditions is violated, the licensing agreement shall be terminated automatically without notice 
from Yamaha. In this case, you must destroy the licensed SOFTWARE and its copies immediately.

4. PRODUCT WARRANTY
Yamaha warrants to the original purchaser that if the SOFTWARE, when used in normal conditions, will not perform the functions 
described in the manual provided by Yamaha, the sole remedy will be that Yamaha will replace any media which proves defective in 
materials or workmanship on an exchange basis without charge. Except as expressly set forth above, the SOFTWARE is provided “as is,” 
and no other warranties, either expressed or implied, are made with respect to this software, including, without limitation the implied 
warranties of merchantability and fitness for a particular purpose.

5. LIMITED LIABILITY
Your sole remedies and Yamaha’s entire liability are as set forth above. In no event will Yamaha be liable to you or any other person for 
any damages, including without limitation any incidental or consequential damages, expenses, lost profits, lost savings or other damages 
arising out of the use or inability to use such SOFTWARE even if Yamaha or an authorized dealer has been advised of the possibility of 
such damages, or for any claim by any other party.

6. GENERAL
This license agreement shall be interpreted according to and governed by Japanese laws.
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SOFTWARE-LIZENZVEREINBARUNG
Die folgende Vereinbarung ist eine rechtsgültige Vereinbarung zwischen Ihnen, dem Endanwender, und der Yamaha Corporation 
(“Yamaha”). Yamaha erteilt dem ursprünglichen Käufer für das beiliegende Yamaha-Softwareprogramm ausschließlich zu den hier 
ausgeführten Bedingungen eine Lizenz zur Verwendung. Bitte lesen Sie diese Lizenzvereinbarung sorgfältig. Durch das Öffnen dieser 
Packung bringen Sie zum Ausdruck, daß Sie alle darin enthaltenen Bedingungen akzeptieren. Wenn Sie nicht mit den Bedingungen 
einverstanden sind, können Sie die Packung ungeöffnet an Yamaha zurückgeben; der Kaufpreis wird in voller Höhe zurückerstattet.

1. ERETILUNG VON LIZENZ UND COPYRIGHT
Yamaha erteilt Ihnen, dem ursprünglichen Käufer, das Recht, ein Exemplar des beiliegenden Softwareprogramms und der darin 
enthaltenen Daten (“SOFTWARE”) als Einzelperson auf jeweils einem Computer zu verwenden. Sie dürfen sie nicht auf mehr als 
einem Computer bzw. einer Computerstation verwenden. Die SOFTWARE bleibt im Besitz von Yamaha und ist durch japanische 
Copyrightgesetze sowie alle anwendbaren internationalen Vertragsbestimmungen geschützt. Sie haben ein Anspruchsrecht auf das 
Eigentum an den Medien, denen die SOFTWARE beiliegt. Daher müssen Sie die SOFTWARE wie alle anderen durch Copyright 
geschützten Materialien behandeln.

2. EINSCHRÄNKUNGEN
Die SOFTWARE ist durch Copyright geschützt. Sie dürfen Sie weder analysieren noch durch anderweitige Methoden reproduzieren. Sie 
dürfen die SOFTWARE weder ganz noch teilweise reproduzieren, modifizieren, verändern, gegen Entgelt oder unentgeltlich verleihen, 
verkaufen oder vertreiben, und Sie dürfen auf der Grundlage der SOFTWARE keine Ableitungen erstellen. Sie dürfen die SOFTWARE 
nicht an andere Computer senden oder in Netzwerke einspeisen. Sie dürfen das Eigentum an der SOFTWARE und den schriftlichen 
Begleitmaterialien auf unbefristeter Basis unter den Voraussetzungen übertragen, daß Sie keine Kopien zurückbehalten und sich der 
Empfänger mit den Bedingungen der Lizenzvereinbarung einverstanden erklärt.

3. BEENDIGUNG
Die Lizenzbedingung des Softwareprogramms wird am Tag, an dem Sie die SOFTWARE erhalten, wirksam. Falls ein Copyrightgesetz 
oder eine Bestimmung der Lizenzbedingungen verletzt wird, wird automatisch und ohne Benachrichtigung durch Yamaha die 
Lizenzvereinbarung beendet. In diesem Fall müssen Sie die lizensierte SOFTWARE und ihre Kopien unverzüglich vernichten.

4. PRODUKTGARANTIE
Yamaha garantiert dem ursprünglichen Käufer, daß, falls die SOFTWARE bei Verwendung unter normalen Bedingungen nicht die in der 
von Yamaha bereitgestellten Anleitung beschriebenen Funktionen erfüllt, die einzige Abhilfe darin bestehen wird, daß Yamaha auf 
Austauschbasis kostenlos jedes Medium ersetzen wird, das Material- oder Verarbeitungsfehler aufweist. Abgesehen von dem oben 
Ausgeführten wird die SOFTWARE “wie die Ware liegt und steht” geliefert, und es werden keine anderen ausdrücklichen oder 
stillschweigenden Garantien hinsichtlich dieser Software übernommen, einschließlich, aber nicht beschränkt auf, die stillschweigenden 
Garantien für handelsübliche Qualität und Eignung für einen bestimmten Einsatzzweck.

5. BESCHRÄNKTE HAFTUNG
Ihre einzige Abhilfe und die gesamte Haftung Yamahas bestehen in dem oben Ausgeführten. Keinesfalls haftet Yamaha Ihnen oder einer 
anderen Person gegenüber für etwaige Schäden, einschließlich, aber nicht beschränkt auf, zufällige Schäden oder Folgeschäden, Kosten, 
Verdienstausfall, verlorene Ersparnisse oder andere Schadenersatzansprüche, die aus der Verwendung der SOFTWARE oder aus der 
Tatsache hervorgehen, daß diese SOFTWARE nicht verwendet werden konnte, selbst wenn Yamaha oder ein autorisierter Händler über 
die Möglichkeit derartiger Schadenersatzansprüche informiert wurde, oder für etwaige andere Ansprüche einer anderen Partei.

6. ALLGEMEINES
Diese Lizenzvereinbarung soll gemäß und in Übereinstimmung mit den japanischen Gesetzen ausgelegt werden.
TOOLS for MOTIF ES6/MOTIF ES7/MOTIF ES8 Installationshandbuch   12



               

Fra
n
ça

is

  
CONTRAT DE LICENCE DE LOGICIEL
Ceci est un contrat entre vous-même, l’utilisateur final, et Yamaha Corporation (« Yamaha »). Le logiciel Yamaha ci-inclus est concédé 
sous licence par Yamaha à l’acheteur original et ne peut être utilisé que dans les conditions prévues aux présentes. Veuillez lire 
attentivement ce contrat de licence. Le fait d’ouvrir ce coffret indique que vous acceptez l’ensemble des termes du contrat. Si vous 
n’acceptez pas lesdits termes, renvoyez le coffret non ouvert à Yamaha pour en obtenir le remboursement intégral. 

1. CONCESSION DE LICENCE ET DROITS D’AUTEUR
Yamaha vous concède le droit d’utiliser, en tant qu’acheteur original, un exemplaire du logiciel et des données afférentes à celui-ci 
(« LOGICIEL ») sur un ordinateur pour utilisateur unique. Vous n’êtes pas autorisé à utiliser ces éléments sur plus d’un ordinateur ou 
terminal d’ordinateur. Le LOGICIEL est la propriété de Yamaha. Il est protégé par les dispositions relatives au droit d’auteur contenues 
dans la législation japonaise et les traités internationaux. Vous êtes en droit de revendiquer l’appartenance du support du LOGICIEL. A 
ce titre, vous devez traiter le LOGICIEL comme tout autre élément protégé par le droit d'auteur. 

2. RESTRICTIONS
Le LOGICIEL est protégé par le droit d’auteur. Vous n’êtes pas autorisé à reconstituer la logique du LOGICIEL ou à reproduire ce dernier 
par quelque autre moyen que ce soit. Vous n’êtes pas en droit de reproduire, modifier, prêter, louer, revendre ou distribuer le LOGICIEL 
en tout ou partie, ou d’utiliser le LOGICIEL à des fins de création dérivée. Vous n’êtes pas autorisé à transmettre le LOGICIEL à d’autres 
ordinateurs ou à l’utiliser en réseau.
Vous êtes en droit de céder, à titre permanent, le LOGICIEL et la documentation imprimée qui l’accompagne, sous réserve que vous n’en 
conserviez aucun exemplaire et que le bénéficiaire accepte les termes du présent contrat.

3. RESILIATION
Les conditions énoncées dans le présent contrat de licence prennent effet à compter du jour où le LOGICIEL vous est remis. Si l’une 
quelconque des dispositions relatives au droit d’auteur ou des clauses du contrat ne sont pas respectées, le contrat de licence sera résilié 
de plein droit par Yamaha, ce sans préavis. Dans ce cas, vous devrez immédiatement détruire le LOGICIEL concédé sous licence ainsi que 
les copies réalisées.

4. GARANTIE PRODUIT
Si, dans des conditions normales d’utilisation, le LOGICIEL ne remplit pas les fonctions décrites dans le manuel fourni, Yamaha s’engage 
vis-à-vis de l’acheteur original à remplacer gratuitement, sur la base d’un échange, tout support reconnu défectueux par suite d’un défaut 
de matière première ou d’un vice de fabrication. Ceci constitue le seul recours opposable à Yamaha. Hormis dans les cas expressément 
énoncés plus haut, le LOGICIEL est livré « en l’état » et toute autre garantie expresse ou implicite le concernant, y compris, de manière 
non limitative, toute garantie implicite de qualité marchande et d’adéquation à un usage particulier, est exclue.

5. RESPONSABILITE LIMITEE
Votre unique recours et la seule responsabilité de Yamaha sont tels qu’énoncés précédemment. En aucun cas Yamaha ne pourra être tenu 
responsable, par vous-même ou une autre personne, de quelques dommages que ce soit, notamment et de manière non limitative, de 
dommages indirects, frais, pertes de bénéfices, pertes de fonds ou d’autres dommages résultant de l’utilisation ou de l’impossibilité 
d’utiliser le LOGICIEL, même si Yamaha ou un distributeur agréé ont été prévenus de l’éventualité de tels dommages, ou de quelque 
autre revendication formulée par une tierce partie.

6. REMARQUE GENERALE
Le présent contrat de licence est régi par le droit japonais, à la lumière duquel il doit être interprété.
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